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I. Introducción 

Desde hace varios años, sectores industriales y organizaciones han instituido los sistemas 

de calidad, debido a que estos promueven la estandarización de la gestión y coordinación en 

la organización como estrategia del aseguramiento de la calidad. Para asegurarla se necesitan 

establecer y cumplir con los Procedimientos Normalizados de Operaciones (PNOs), estos son 

documentos con instrucciones para llevar a cabo de manera reproducible una operación de 

manera precisa y secuencial, de la misma forma, determinan la responsabilidad e identifican 

los mecanismos básicos para la instrumentación y el adecuado desarrollo, con el propósito 

de generalizar y unificar criterios básicos para el análisis de los procedimientos que realicen 

los distintos departamentos, señalando lo que se pretende obtener con la ejecución de los 

mismos. Estos deben contener: objetivo, alcance, definiciones, responsabilidad, frecuencia, 

desarrollo del proceso, referencias bibliográficas, anexos y control de cambios (Cema, 2018; 

Martínez, 2007; Secretaria de Salud, 2021).  

Ventajas de utilizar PNOs (Montesinos, 2014):   

 
 Permiten que el mismo trabajo sea desarrollado de la misma manera por los 

empleados.   

 Proveen instrucciones, por lo que sirve como guía de entrenamiento.   

 Son una referencia y sirven como consulta.   

 Sirven para verificar cada etapa del proceso.   

 Ayuda a auditar cada operación.   

 
II. Objetivos 

II.I General:   

● Efectuar una revisión bibliográfica mediante manuales y diferentes bases de datos para 

la elaboración de PNOs de equipos del laboratorio con el fin de realizar operaciones de 

manera reproducible.   

 
II.II Particulares:   

● Investigar e integrar información mediante la documentación existente en el uso de 

diferentes equipos como la balanza (BP110S sartorius), la centrifuga (Eppendorf 5417R), 

el microscopio (Leica MZ26), Bioteck (FLx 800), el Espectrofotometro de absorción 

atómica (AAnalyst 600) y HPLC (Agilent 1100 series), para la elaboración de PNOs.   
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● Investigar en fuentes bibliográficas mediante el uso de la base de datos como la 

BiDiUAM-X para obtener las recomendaciones de uso y cuidados de los diferentes 

equipos.   

● Seleccionar información mediante la revisión de los manuales de cada uno de los 

equipos para la elaboración de PNOs.   

● Recopilar y discernir a partir de la información de bitácoras, métodos desarrollados y 

validados para determinar las condiciones analíticas empleadas en los diferentes 

equipos.   

● Realizar los PNOs de los equipos como la balanza (BP110S sartorius®), la centrifuga 

(Eppendorf® 5417R), el microscopio (Leica® MZ26), Bioteck® (FLx 800), el 

Espectrofotómetro de absorción atómica (AAnalyst® 600) y HPLC (Agilent® 1100 series) 

para tener la información de uso actualizada y optimización de su funcionamiento.   

 
III. Metodología 

El presente proyecto se desarrolló a través de la búsqueda de los manuales de los 

diferentes equipos, los cuales se consultaron en bases de datos con acceso gratuito en 

inglés y español. Para su búsqueda se utilizaron palabras claves como son: Handbook, 

user manual, Microscope Leica® MZ26, HLPC Agilent®, Bioteck FLx® 800, Atomic 

absorption spectroscopy Atomic Analyst® 600, BP110S Sartorius®, Eppendorf® 5417R, 

PNO. SOP.   

 
Con estos manuales se pudo conseguir las características, generalidades y el uso 

adecuado de los equipos. También se recopilo información de los métodos desarrollados 

con los equipos, para comprobar el correcto funcionamiento de los PNOs.   

 

IV. Resultados y meta alcanzada 

En este informe se presentan los diferentes PNOs que se realizaron para los equipos del 

laboratorio, cada uno de ellos describe como llevar a cabo los procedimientos de uso y 

limpieza, de manera que estas operaciones sean reproducibles con el personal del 

laboratorio. Estos PNOs se pueden revisar en los anexos, de este informe.   

El PNO de la balanza analítica (BP110S Sartorius®) se encuentra en el Anexo 1, este 

PNO fue el primero en realizar debido a lo sencillo de elaborar, porque se tenía 

conocimiento del equipo y en el manual donde se consultó la información era bastante 

claro.   
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En el anexo 2, se encuentra el PNO de la centrifuga (Eppendorf® 5417R), este PNO 

también fue también sencillo de elaborar, ya que el manual venia detallado y claro.  Y no 

se presentó ningún inconveniente para obtener la información completa. 

El PNO del equipo del Microscopio (Leica® MZ6), se encuentra en el anexo 3, este 

procedimiento requirió más atención en su elaboración, ya que no se tenía el conocimiento 

del software, por lo cual se requirió diversos documentos, una búsqueda detallada, 

además de una persona capacitada previamente para que ejecutará comandos no claros 

en la documentación recopilada.   

Los posteriores PNOs presentados fueron los que presentaron mayor dificultad para 

realizarlos, porque se cuentan con un software complejo que monitorea las operaciones 

que tiene el equipo, por lo que tuvo que presentarse el escrito con mayor detalle.   

Por lo tanto, en el anexo 4, se presenta el PNO del Bioteck® (FLx 800), un equipo de 

lector de placas por fluorescencia, este PNO fue el más largo porque cuenta con  modo de 

ejecución automática y manual, siendo el más complejo el del modo manual.   

En el anexo 5, se encuentra el PNO del espectrofotómetro de absorción atómica 

(AAnalyst® 600), con este equipo se tenía conocimiento de su ejecución, pero se buscó 

más información en manuales, así como bases de datos para complementar y verificar su 

uso, así como la asesoría de una persona capacitada.   

Finalmente, el PNO que se elaboró fue el del cromatógrafo de líquidos de alta resolución 

CLAR (Agilent® 1100 series), el cual se encuentra en el anexo 6, en este se recopilo 

información para su elaboración y una persona autorizada apoyo a entender mejor cómo 

funcionaba este equipo, así como el uso del software.   
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V. Conclusiones 

Los PNOs son de suma importancia en los laboratorios, ya que nos ayudan a tener un 

orden y podemos utilizar de forma correcta los equipos evitando daños en estos. Estos 

PNOs, se han puesto en prueba para demostrar que el documento sea claro y conciso, y 

con esto se ha demostrado que ayudara a que las actividades y su uso se realice de 

manera sistemática, así como de manera correcta. Estos serán de gran apoyo para la 

capacitación del personal y la estandarización en su operatividad.   

 
 

VII. Perspectiva 

Con la recopilación de estos PNOs se espera que el personal involucrado en el 

laboratorio mantenga un uso adecuado y ordenado de los equipos y cumpla con   todas las 

especificaciones señaladas en cada PNO.   

Se espera que, con estos PNOs, sea el inicio y se realicen más acciones para que se 

pueda implementar un Sistema de Gestión de Calidad, adecuado para el Instituto al cual 

pertenece el laboratorio.   
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1. OBJETIVO 
Describir las instrucciones para el uso y manejo adecuado de la Balanza BP110S sartorius. 

2. ALCANCE 
Este documento está dirigido a todas las operaciones de pesada que se vayan a realizar con la 
balanza BP110S. 

3. FRECUENCIA 
Deberá emplearse este procedimiento cada vez que se realice una pesada con la balanza BP110S 
sartorius. 

4. RESPONSABILIDAD 
La responsabilidad de aplicación y alcance de dicho procedimiento recae sobre todo el personal 
que trabaja con la balanza analítica (BP1105 Sartorius) del laboratorio de neuroquímica del 
Instituto Nacional de Neurología y Neurocirugía. 
Es responsabilidad de los encargados de generar recurso humano dar a conocer y verificar que este 
documento sea aplicado. 

5. DEFINICIONES Y SIGLAS 
5.1. Capacitación: actividades encaminadas a proporcionar o reforzar conocimientos en el 

personal. 
5.2. Control de cambios: Conjunto de actividades documentadas que especifica los pasos para 

incorporar modificaciones previstas por una oportunidad y/o necesidad. 
5.3. Copia controlada: Copia emitido por el Sistema de Gestión de calidad, la cual cuenta con un 

sello de la leyenda de “copia controlada” y su ubicación es rastreable. 
5.4. SG: Centro Técnico. 
5.5. Firma de conocimiento: Requisito básico de capacitación, del cual se debe tener un registro 

del personal que se ha informado del PNO, con su firma y fecha en que se le dio a conocer el 
documento. 

5.6. Formato: Hace referencia a la forma como debe ser escrita la información. 
5.7. PNO: Procedimiento normalizado de operación. 
5.8. Procedimiento normalizado de operación o procedimiento: Documento que contiene las 

instrucciones necesarias para llevar a cabo de manera reproducible una operación. 
5.9. Rastreabilidad: Capacidad de reconstruir la historia, localización de un elemento o deuna 

actividad, por medio de registros de identificación. 
5.10. Registro: Documento que presenta evidencia de las acciones realizadas para demostrarel 

cumplimiento de actividades o instrucciones. 
 

Emitió Revisó Autorizó 

 
QFB. Jocelyn Sánchez Jiménez 

Químico Analista 

 
Dr. Javier Aguila Rosas 

Profesor de tiempo completo D 

 
Dr. Camilo Ríos Castañeda 

Profesor asociado D 
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6. DESARROLLO DEL PROCESO 
6.1. Manejo de la balanza 

6.1.1. Calentar la balanza conectándola a la corriente eléctrica por lo menos 30 minutos para 
alcanzar la temperatura de funcionamiento necesaria. 
Nota: Únicamente se realizará un calentamiento previo después de que se conecta por primera 

vez a la corriente eléctrica o después de una interrupción prolongada de corriente. 

6.1.2. Verificar que la burbuja de aire de mercurio, se sitúe en el centro del círculo del nivel (Ver 
Anexo 1 A). 

6.1.3. Si se requiere nivelar la balanza realizar lo siguiente, de lo contrario ir al punto 6.1.4. 
Girar los “pies” niveladores según las necesidades para que la burbuja de mercurio quede 

centrada dentro del círculo del indicador de nivel. (Anexo 1). 

Nota: Para levantar la balanza, girar las patas niveladoras en el sentido de las manecillas del 

reloj. Para bajar el equilibrio, retraer las patas niveladoras delanteras (girar en sentido 
antihorario). 

6.1.4. Deslizar las puertas laterales hacia atrás para Octirlas y quitar el plato de la balanza para 
comprobar la correcta limpieza de esta 

6.1.5. Si es necesario, limpiar la balanza hacer uso de la brocha destinada a ello. 
En caso de ser necesario realizar una limpieza profunda a la balanza seguir los pasos 
indicados en el apartado 6.2.12. 

 

6.1.6. Encender la pantalla oprimiendo la tecla ON/OFF ( ), ver Anexo 2. 

6.1.7. Autoanálisis 

Realizar control automático de las funciones electrónicas de la balanza. Esto se determina al 

observar en la pantalla la lectura de cero. 

La balanza está lista para funcionar, cuando aparece la indicación cero (Anexo 3). 

En la pantalla de la balanza pueden aparecer los siguientes símbolos: 

6.1.7.1. “O” arriba a la derecha para OFF/ apagado 
La balanza ha sido desconectada de la red de corriente eléctrica. 

6.1.7.2.       “O” abajo a la izquierda para standby /en espera La 

pantalla ha sido apagada con la tecla ON/OFF y la balanza se encuentra 

lista para funcionar de inmediato al encender nuevamente la pantalla, sin 

calentamiento previo. 

6.1.7.3.         “ ” para busy/ocupado 

Aparece después de encender la balanza y desaparece recién cuando se 

oprime alguna tecla. 

Nota: Si aparece  cuando se realiza una operación pesada, es porque el procesador 

todavía está realizando una función y no acepta otro comando para realizar cualquier 

otra operación en ese momento. 
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6.1.8. Calibrar la balanza cuando la pantalla muestre lectura cero presionando la tecla CAL. 

6.1.8.1. Si alguna interferencia afecta el procedimiento de la calibración, se observará el 
código error “Err 02”. En este caso, oprimir la tecla TARE y presionar CAL. 

 

Nota: Se deberá ajustar/calibrar la balanza después de cada periodo de calentamiento, 
antes de la primera medición siguiendo los siguientes puntos, cada vez que cambie de 
lugar de instalación o si varían las condiciones ambientales (especialmente de 
temperatura). 

 

6.2. Desarrollo de la operación de la pesada 
6.2.1. Tener listo el material a pesar. Comprobar el nombre, caducidad y fotosensibilidad del 

material. 
6.2.2. Trasladar el material a la zona de pesada y situarlas todas al mismo lado de la balanza. 
6.2.3. Esperar la puesta a cero de la balanza y Octir las puertas de la balanza. 

6.2.4. Colocar en el plato de la balanza el papel o recipiente de pesada adecuado que permita 
identificar el material a pesar y garantizar la integridad de la pesada. 

Nota: Al colocar dicho papel o recipiente y realizar la pesada considerar la capacidad máxima 
de 110g. 

6.2.5. Oprimir la tecla TARE para poner el indicador de peso a cero. 
6.2.6. Octir el envase correspondiente del material a pesar. 

6.2.7. Colocar la muestra a pesar sobre el recipiente de pesada. 

6.2.8. Leer el valor del peso cuando aparezca como símbolo de estabilidad la unidad de peso “g” u 
otra unidad de peso seleccionada. 

6.2.9. Si se requiere cambiar unidades de peso primero se debe realizar la configuración 
correspondiente siguiendo las indicaciones del Anexo 4, de lo contrario pase al punto 6.2.10. 

6.2.10. Cerrar el envase del producto (en la zona de pesada no debe haber más de un envase abierto) 
y situarlo al otro lado de la balanza. 
En caso de vertidos accidentales de productos, limpiar inmediatamente el plato de pesada y/o 
las diferentes partes de la balanza, retirando con cuidado cualquier residuo de muestra / polvo 
derramado utilizando una brocha Y Asegurase de que no entre líquido o polvo en la hendidura 
rodeada al adaptador del plato. 

6.2.11. Una vez finalizada las pesadas apagar la balanza y limpiarla. Si es necesario, emplear un trozo 
de paño humedecido con un detergente suave, asegurándose de que no entre líquidos en la 
carcasa de labalanza. Posteriormentesecarconpañosuave. 

6.2.12. Trasladar los envases originales del material al almacén y colocarlos en su ubicación 
correspondiente. 

6.2.13. Registrar el uso del equipo en la bitácora de la balanza BP110s sartorius con el formato 
FOR-SG-002/1 que se encuentra a lado 

 

6.3. Registro en el Formato de conocimiento 

6.3.1. Posterior a la lectura del presente documento, llenar el formato FOR-SG-001/1 
Registro de conocimiento de PNO. 

6.3.2. Este formato solo se llenará la primera vez que se lea el presente documento. 
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FINAL. 

7. FORMATOS 

Código de formato Nombre del formato 

FOR-SG-001/1 Registro de conocimiento de PNO 
FOR-SG-002/1 Registro de uso del equipo 

8. CONTROL DE CAMBIOS 
 

Número de 
cambio 

Realizó Descripción del cambio 

1ª Edición QFB. Jocelyn Sánchez Jiménez Emisión original 
 

9. REFERENCIA BIBLIOGRÁFICA 

9.1. Kern . (2000). Manual de instrucciones Balanzas analíticas y de precisión. Consultado el 28 de noviembre 
2021, de http://www.kern-sohn.com/manuals/files/Spanish/770-GS-GJ-BA-s-0023.pdf 

9.2. Sartorius. (2020). Sarorius Basic plus. Consultado el 28 de noviembre 2021, de 
https://www.manualslib.com/products/Sartorius-Bp-110-0ce-3748071.html 

9.3. Secretaria de Salud. (2021). Procedimientos Normalizados de Operaciones. México 
 
 

10. Diagrama 

http://www.kern-sohn.com/manuals/files/Spanish/770-GS-GJ-BA-s-0023.pdf
http://www.manualslib.com/products/Sartorius-Bp-110-0ce-3748071.html
http://www.manualslib.com/products/Sartorius-Bp-110-0ce-3748071.html
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11. ANEXOS 
Anexo 1. Nivelación de la balanza 

 
 

 
A. Retracción de pies auxiliares posteriores B. Extensión de pies auxiliares posteriores C. Indicaciones para nivelar balanza 

 
 
 

 
Anexo 2. Pantalla, panel de control y elementos de la balanza BP110S sartorius 

 

 

1. Pantalla / indicador de peso 
2. Tecla TARE 
3. Tecla ON/OFF (Encender/apagar) 
4. Tecla CF (Clear Function)/ función de 

borrado 

5. Tecla TARE y puesta a cero 
6. Tecla de impresión (salida de datos) 
7. Tecla de función F 
8. Tecla CAL, tecla de calibración 
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10. Plato de pesaje 
11. Soporte 
12. Anillo de escudo 
13. Etiqueta de identificación metrológica para saldos verificados aprobados para su uso como instrumento legal 
14. Pie nivelador 
15. Puerto de interfaz de datos 
16. Interruptor de acceso al menú 
17. Conector del adaptador 
18. Indicador de nivel 
19. Orejeta para fijar un dispositivo de bloqueo 
20. etiqueta del fOcticante 
21. Etiqueta de identificación de verificación con metrológica de datos para saldos verificado 
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Anexo 3. Autoanálisis 

 
 

Anexo 4. Ajuste de unidades 
 

 

 
 

 

 
1. Retirar la tapa protectora del menú interruptor de acceso (Anexo 2, número 

16) situado en el panel trasero de la computadora del dispositivo. 
2. Apagar la balanza. 
3. Encender la balanza. 
4. Mientras se muestran todos los segmentos, presionar brevemente la tecla 

TARE. 
5. Mover el interruptor de acceso al menú, en la dirección de la flecha cuando 

aparezca la indicación “-”.  

6. Oprimir la tecla CAL hasta que aparezca el primer dígito del código 
correspondiente a la unidad de peso a configurar (Ver imagen a 
continuación) 

7. Oprimir la tecla  hasta que aparezca la segunda cifra del código. 

8. Oprimir la tecla CAL hasta que aparezca el segundo dígito del código 
correspondiente a la unidad de peso. 

9. Oprimir la tecla  hasta que aparezca la tercera cifra del código. 
10. Oprimir la tecla CAL hasta que aparezca el tercer dígito del código 
11. Para confirmar el ajuste oprimir TARE. 
12. La confirmación se indicará con “O” detrás del código. 

 
13. Una vez terminada la configuración bloquear el acceso al menú 

nuevamente mediante el interruptor.  

14. Para alternar entre dos unidades de peso presionar la tecla F. 
15. La segunda unidad se identificará con el símbolo de pantalla “R1”. 
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1. OBJETIVO 
Establecer los lineamientos para el uso y manejo de la Centrífuga Eppendorf 5417R. 

2. ALCANCE 
Este procedimiento es aplicable a todas las operaciones que se realicen con la Centrífuga Eppendorf 
5417R ubicada en el Laboratorio de Neuroquímica del Instituto Nacional de Neurología y 
Neurocirugía. 

3. FRECUENCIA 
El presente procedimiento debe llevarse a cabo cada vez que se utilice de la Centrífuga Eppendorf 
5417R. 

4. RESPONSABILIDAD 
Es responsabilidad del Departamento de Centro Técnico de Neuroquímica dar a conocer y 
verificar el cumplimiento del presente documento dentro del Laboratorio de Neuroquímica. 
Es responsabilidad del personal del laboratorio de Neuroquímica dar a conocer y hacer cumplir el 
presente procedimiento al personal externo que haga uso de la Centrífuga Eppendorf 5417R. 
Es responsabilidad de cada usuario que haga uso del equipo cumplir con lo establecido en el 
presente documento. 

5. DEFINICIONES Y OSGVIATURAS 
Procedimiento normalizado de operación o procedimiento: Documento que contiene 
las instrucciones necesarias para llevar a cabo de manera reproducible una operación. 
Rastreabilidad: Capacidad de reconstruir la historia, localización de un elemento o de una actividad, 
por medio de registros de identificación. 
Registro: Documento que presenta evidencia de las   acciones   realizadas   para   demostrar 
el cumplimiento de actividades o instrucciones. 
PNO: Procedimiento normalizado de operación. 
SGC: Sistema de Gestión de Calidad. 
SG: Centro técnico. 
Formato: Hace referencia a la forma como debe ser escrita la información. 
Copia controlada: Copia emitida por el Sistema de Gestión de calidad, la cual cuenta con un sello de 
la leyenda de “copia controlada” y su ubicación es rastreable. 
Capacitación: actividades encaminadas a proporcionar o reforzar conocimientos en el personal. 
RPM: revoluciones por minuto 
RCF: fuerza centrífuga relativa 
Rotor: Es la pieza que gira impulsada por el motor y sobre la cual se coloca la muestra. 
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6. DESARROLLO DEL PROCESO 
6.1. Preparación para el uso de la centrifuga. 

6.1.1. Encendido de la centrífuga 
6.1.1.1. Conectar el equipo a la red eléctrica. 
6.1.1.2. Presionar el botón ON/OFF, que se encuentra en la parte inferior derecha de 

la centrífuga; ver Anexo 1. 
Nota: Los valores de la última ejecución aparecen en la pantalla. 

6.1.2. Carga de rotores 

6.1.2.1. Presionar el botón  para Octir la tapa de la centrífuga. 
Nota: Para ver la pantalla y panel de control ver Anexo 2. 

6.1.2.2. Quitar la tapa del rotor, aplicando un poco de presión y girando la tapa del 
rotor en sentido contrario a las agujas del reloj. 

6.1.2.3. Verificar la carga máxima del rotor que se indica en el mismo (30 tubos x 3.75 
g). 

6.1.2.4. Verificar que los tubos a utilizar sean del mismo tipo y contener la misma 
cantidad de llenado. 

6.1.2.5. Utilizar la balanza (Ver PNO-SG-01 Procedimiento Normalizado de 
Operaciones para el uso y manejo de la Balanza BP110s sartorius) para 
mantener bajas las diferencias de peso entre los tubos llenos. Esta protege la 
unidad y reduce el ruido de función. 

6.1.2.6. Cargar los rotores y adaptadores únicamente con los tubos destinados a ello. 
Los tubos de 1.5mL y 2.0 mL se pueden introducir directamente. 
Nota: Se pueden utilizar tubos de centrífuga de 0.5mL y 0.4mL con 
adaptadores, así como tubos de PCR de 0.2mL. 

6.1.2.7. Insertar los tubos uno frente al otro en pares en los orificios del rotor para 
asegurar una carga simétrica como se indica en el Anexo 3. 

6.1.2.8. Colocar la tapa del rotor verticalmente sobre el rotor. 
6.1.2.9. Bloquear el rotor girando la tapa del rotor en el sentido de las agujas del reloj 

hasta que no se pueda girar más como se indica en el Anexo 4. 
6.1.2.10. Cerrar la tapa de la centrífuga. 

Nota: Si se enciende la luz verde de control, que se encuentra en el botón open, 
cerrarla nuevamente. 

El símbolo    muestra que el rotor no se mueve. 
6.1.3. Modificar valores de velocidad de rotación . 

6.1.3.1. Presionar la flecha hacia arriba         del botón  para aumentar la 
velocidad. 

6.1.3.2. Presionar la  flecha hacia abajo  del botón   para disminuir la 
velocidad. 
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Nota: Cuando ambas teclas de flecha se presionan simultáneamente, la 
centrífuga cambia de "RPM" a "RCF". El símbolo rcf aparece en la pantalla. 

6.1.4. Modificar tiempo de ejecución (minutos / segundos). 

6.1.4.1. Presionar las teclas de flecha del botón  para colocar el tiempo de 
ejecución. 

6.1.4.2. Utilizar el botón de Time si se desea realizar una operación continua "oo" por 
encima de 99 minutos o por debajo de 10 segundos. 
Nota: Si la centrífuga funciona durante más de 99 minutos, "99" parpadea. 
En la pantalla de tiempo, "oo" indica operación continua. El operador debe 
tomar el tiempo para detener la operación. 

6.1.4.3. Mantener presionado el botón  durante el tiempo deseado si se desea 
realizar un centrifugado corto. El tiempo que ha transcurrido se muestra en 
segundos. 
Nota: Las corridas con una duración de 10, 20 o 30 segundos se pueden 
configurar usando la selección de tiempo. 

6.1.5. Modificar la temperatura preseleccionada . 

6.1.5.1. Presionar   las   teclas   de   flecha   del   botón       para colocar la 
temperatura deseada. 

6.1.5.2. Establecer la temperatura en un rango de - 9 ° C a + 40 ° C. 
Nota: Una vez que se alcanza la temperatura establecida, se indicará una 
desviación de± 3 ° C en la pantalla. 
***En caso de tener problemas con la temperatura revisar los siguientes 
puntos, de lo contrario dirigirse al apartado 6.2.*** 

6.1.5.3. Si la temperatura se desvía más de 5 ° C, la centrífuga se apaga con una señal 
de advertencia. 

6.1.5.4. Para proteger el dispositivo, la refrigeración se apaga automáticamente si la 
centrífuga no se utiliza durante más de seis horas o si la tapa esté abierta. 

6.1.5.5. Si el dispositivo se apaga, la temperatura deseada se puede volver a alcanzar 

rápidamente a través del botón . 
Nota: durante la ejecución, la velocidad de rotación, la temperatura y el tiempo 
restante se muestran en la pantalla. 

6.2. Centrifugación 
6.2.1. Centrifugación con arranque o parada suave. 

6.2.1.1. Presionar el botón   antes o durante la aceleración para que las fases de 
aceleración y el frenado se extienden aproximadamente 60 segundos. Es 
indicado por la lámpara en el botón. 
Nota: El modo suave no se puede apagar una vez finalizada la aceleración 
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6.2.2. Presionar el botón para iniciar la ejecución. 

El símbolo   de la pantalla parpadea mientras el rotor está girando. 
6.2.3. Esperar el tiempo que tarde la corrida. 

6.2.4. Presionar el botón  si se desea parar la corrida, de caso contrario dejar que 
finalice la corrida. Una vez que termine la corrida, se escuchará un sonido de alerta, 
que nos indica que se puede Octir la tapa de la centrífuga. 

6.2.5. Octir la tapa del rotor. 
6.2.6. Retirar el material para centrifugar. 
6.2.7. Realizar el registro correspondiente en la bitácora de uso con el formato FOR-SG- 

001/1 Registro de uso del equipo Centrífuga Eppendorf 5417R. 
Nota: Después del final de una corrida, o después de que se haya interrumpido una corrida 
presionando el botón Stop, el rotor se para. Durante el proceso de frenado, la pantalla de tiempo 
parpadea y se muestra el tiempo de centrifugado transcurrido. 

6.3. Limpieza del equipo 
6.3.1. Limpiar regularmente el exterior de la centrífuga y la cámara del rotor con 

detergente neutro (ej. mezcla de isopropanol/agua al 70% o un desinfectante a 
base de alcohol). 

6.3.2. Octir la tapa de la centrífuga y desconectarla de la corriente. 
6.3.3. Desenroscar el rotor con la llave hexagonal suministrada y limpiarlo por separado. 
6.3.4. Limpiar la cámara del rotor solo con un paño húmedo. 
6.3.5. Después de limpiar con detergente, enjuagar los sellos de goma en la cámara del 

rotor con agua y lubricar con glicerina. 
6.3.6. Limpiar regularmente el rotor y las cubetas, con líquidos de limpieza neutros. 
6.3.7. Revisar el rotor mensualmente en busca de residuos y corrosiones, particularmente 

los orificios del rotor. 
Nota El mensaje “CLEAn ro” aparecerá en la pantalla de la centrífuga tres veces 
después de cada 200 ejecuciones. 

6.4. Registro en el Formato de conocimiento 
6.4.1. Posterior a la lectura del presente documento, llenar el formato FOR-SG-001/1. 
6.4.2. Únicamente se realizará el registro en el formato FOR-SG-001 Registro de 

conocimiento de PNO´s la primera vez que se lea el presente documento. 
 

FINAL. 
7. FORMATOS 

Código de formato Nombre del formato 

FOR-SG-003/1 Registro de conocimiento de PNO´s 
FOR-SG-001/1 Registro de uso del equipo Centrífuga Eppendorf 5417R. 
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8. CONTROL DE CAMBIOS 

Número de 
cambio 

Realizó Descripción del cambio 

1ª Edición QFB. Jocelyn Sánchez Jiménez Emisión original 
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10. DIAGRAMA DE FLUJO 
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11. ANEXOS. 
Anexo 1. Equipo Eppendorf centrifuge 5417R 

 
 

Anexo 2. Pantalla y panel de control 

El equipo cuenta con la siguiente pantalla y panel de control con la que se establecen los parámetros de 
tiempo, temperatura y velocidad deseados. 

A. Temp: Control de temperatura 
B. Speed: Control de Velocidad 
C. Time: Control de Tiempo 
D. Open: Octir tapa de centrífuga 
E. Fast cool: Enfriado rápido 
F. Short: Centrifugado corto 
G. Soft: Centrifugación con arranque o 
parada suave 
H. Start/Stop: Iniciar/Parar 
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Anexo 3. Carga simétrica de rotores. 
 

 

 

Correcto Incorrecto 

 
Anexo 4. Cerrado de la tapa del rotor. 
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1. OBJETIVO 
Establecer los lineamientos a seguir para el uso y manejo del Microscopio Leica MZ6. 

2. ALCANCE 
Este procedimiento es aplicable a todas las operaciones que se realicen con el Microscopio Leica 
MZ6 ubicado en el Laboratorio de Neuroquímica del Instituto Nacional de Neurología y 
Neurocirugía. 

3. FRECUENCIA 
El presente procedimiento debe llevarse a cabo cada vez que se haga uso del Microscopio Leica 
MZ6. 

4. RESPONSABILIDAD 
Es responsabilidad del Departamento de Centro Técnico de Neuroquímica dar a conocer y 
verificar el cumplimiento del presente documento dentro del Laboratorio de Neuroquímica. 
Es responsabilidad del personal del laboratorio de Neuroquímica dar a conocer y hacer cumplir el 
presente procedimiento al personal externo que haga uso del Microscopio Leica MZ6. 
Es responsabilidad de cada usuario que haga uso del equipo hacer cumplir lo establecido en el 
presente documento. 

5. DEFINICIONES Y OSGVIATURAS 
5.1. Procedimiento normalizado de operación o procedimiento: Documento que contiene 

las instrucciones necesarias para llevar a cabo de manera reproducible una operación. 
5.2. Rastreabilidad: Capacidad de reconstruir la historia, localización de un elemento o de 

una actividad, por medio de registros de identificación. 
5.3. Registro: Documento que presenta evidencia de las acciones realizadas para demostrar 

el cumplimiento de actividades o instrucciones. 
5.4. PNO: Procedimiento normalizado de operación. 
5.5. SG: Centro técnico. 
5.6. Formato: Hace referencia a la forma como debe ser escrita la información. 
5.7. Copia controlada: Copia emitida por el Sistema de Gestión de calidad, la cual cuenta con un 

sello de la leyenda de “copia controlada” y su ubicación es rastreable. 
5.8. Capacitación: actividades encaminadas a proporcionar o reforzar conocimientos en el 

personal. 
5.9. Ocular: son un sistema de lentes, acopladas en la parte superior del tubo del microscopio, 

cuya función es formar una imagen virtual y amplificada de la imagen real creada por el 
objetivo. 
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6. DESARROLLO DEL PROCESO 
6.1. Preparación para el uso del Microscopio Leica MZ6 

6.1.1. Encendido del Microscopio Leica MZ6 
6.1.1.1. Conectar el microscopio a la corriente eléctrica. 
6.1.1.2. Encender el microscopio empleando el interruptor que modifica la intensidad 

de la luz de la lámpara (Ver Anexo 1, número 15). 
Nota: Si se requiere que la luz se localice por la parte superior de la muestra, la lámpara 
se puede colocarse fuera de la base del microscopio, sobre el soporte que se encuentra 
del lado izquierdo del mismo (Ver Anexo 1, número 13 y 14). 

6.1.2. Ajuste del Microscopio Leica MZ6 
6.1.2.1. Colocar el objeto a observar debajo del objetivo como se muestra en el Anexo 

2. 
6.1.2.2. Ajustar oculares y las dioptrías. Si no es requerido pase al punto 6.2. 
6.1.2.3. Ajustar los oculares considerando si el usuario usa o no lentes. Si el analista 

usa lentes, empujar suavemente los oculares hacia abajo (ver Anexo 3A). 
6.1.2.4. Jalar suavemente los oculares hacia arriba, si el analista no requiere lentes (ver 

Anexo 3B). 
6.1.2.5. Ajustar las dioptrías girando los oculares hacia izquierda o derecha para el 

enfoque del objeto (Anexo 3C). 
6.2. Visualización de imagen 

6.2.1. Para utilizarlo de manera manual observar a través de los oculares y pasar al punto 
6.2.1.1. 

6.2.1.1. Realizar los pasos del punto 6.2.9 al 6.2.11. 
6.2.1.2. Observar el objeto de interés 
6.2.1.3. Ir al punto 6.4. 

6.2.2. Para observar las imágenes desde el monitor, realizar mediciones o/y tomar 
fotografías, hacer uso del software IM500. 

Nota: si la cámara no se encuentra en el microscopio, instalarla como se indica en el Anexo 
4. 
6.2.3. Encender el monitor al que se encuentra conectada la cámara del microscopio. 
6.2.4. Crear una carpeta en “Mis documentos” con su nombre e inicial de su primer apellido 

para guardar las imágenes. 
6.2.5. Octir el programa IM500. 
6.2.6. Seleccionar Archivo > Demo_Gallery (...) (Ver Anexo 5) 

6.2.7. Seleccionar el ícono de llave del programa (Ver Anexo 6). 

6.2.8. Realizar un balance de blancos trazando un rectángulo con el ratón en la imagen y 
seleccionando “White balance”. 

6.2.9. Enfocar utilizando el tornillo giratorio de ajuste de enfoque, localizados del lado 
izquierdo o derecho del microscopio (Ver Anexo 1, número 3a). 
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Nota: Comenzar a enfocar con el menor aumento “zoom” (0.63), ya que brinda un mayor 
campo de visión. 
Si el movimiento del tornillo giratorio de ajuste de enfoque (Ver Anexo 1, número 3a) no 
presenta la resistencia necesaria o se encuentra apretado, ajustar sujetando el tornillo 
izquierdo y girando el derecho de manera contraria, hasta alcanzar la resistencia deseada 
durante el enfoque (Ver Anexo 7). 

6.2.10.  Seleccionar el aumento deseado 0.63, 0.8, 1.0, 1.25, 1.6, 2, 2.5, 3.2 o 4.0 girando el 
cambiador de aumentos (Ver Anexo 1, número 1) y presionar el interruptor de 
aumentos (Anexo 1, número 1 y 2) para mantenerlo fijo. 

6.2.11.  Ajustar la intensidad de la luz si es necesario girando el interruptor (Anexo 1, número 
15). 

6.2.12. Seleccionar el botón Acquire (Ver Anexo 8). 
6.2.13.  Guardar las imágenes debidamente identificadas en la carpeta creada previamente 

en “Mis documentos”. 
6.2.14. Seleccionar el aumento al que se tomó la imagen (Anexo 9) indicado en el microscopio 

(Anexo 1, número 1) y aceptar el cambio. 
6.2.15. Cerrar la ventana para obtener la imagen. 

6.3. Funciones del software IM500 
6.3.1. Seleccionar el ícono Medición , para realizar algunas de las siguientes 

funciones enlistadas, las cuales se desplegarán en un menú del lado izquierdo de la 
pantalla (Ver Anexo 10). 

6.3.1.1. Agregar una barra de calibración o agregar datos a la imagen, dirigirse al punto 
6.3.2. 

6.3.1.2. Realizar mediciones de superficies, ir al punto 6.3.3. 
6.3.1.3. Realizar un conteo de objetos, ver punto 6.3.4. 
6.3.1.4. Realizar una medición de un perímetro lineal, ver punto 6.3.5. 
6.3.1.5. Realizar una medición de un perímetro no lineal, ir al punto 6.3.6. 
6.3.1.6. Realizar medición de un radio, pasar al punto 6.3.7. 
6.3.1.7. Realizar medición de un ángulo, ir al punto 6.3.8. 
6.3.1.8. Realizar medición de distancia entre dos rectas de referencia. Ir al punto 6.3.9. 

6.3.2. Agregar barra de calibración y datos 

6.3.2.1. Seleccionar icono Calibración . 

6.3.2.2. Seleccionar el ícono Barra de calibración   y marcar el recuadro del 
parámetro que desee que se muestre en la imagen. 

Nota: Para ajustar los parámetros de calibración: grosor, tamaño, forma de la barra de 
calibración, fuente y fondo; así como agregar datos a la imagen: aumento, descripción 
y el nombre, se despliega una ventana en donde se pueden realizar (Anexo 11). 

6.3.2.3. Guardar los cambios. 
6.3.2.4. Ir al punto 6.3.10. 
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6.3.3. Medir área o superficie 

6.3.3.1. Seleccionar icono Área  (Anexo 10). 

6.3.3.2. Seguir el contorno de la superficie que se desea medir haciendo clic 
intermitentemente, como si se deseara realizar una línea punteada. 

6.3.3.3. Dar doble clic izquierdo y observar el menú lateral izquierdo, donde aparecerá 
la magnitud de la medición (Anexo 12). 

Nota: se puede modificar el color y grosor del contorno de la superficie medida dando 
un clic izquierdo. 

6.3.3.4. Ir al punto 6.3.10 . 
6.3.4. Conteo de objetos 

6.3.4.1. Seleccionar icono Contador  (Anexo 10). 

6.3.4.2. Seleccionar con un clic izquierdo los objetos se desea contar. 
6.3.4.3. Dar doble clic izquierdo y en el menú lateral izquierdo aparecerá la cantidad 

de objetos (Anexo 12) contados. 
6.3.4.4. Ir al punto 6.3.10. 

6.3.5. Medición lineal 

6.3.5.1. Seleccionar icono Vector . 

6.3.5.2. Dar clic izquierdo y trazar el perímetro lineal que se desea medir. 
6.3.5.3. Dar doble clic derecho y en el menú lateral izquierdo aparecerá la magnitud de 

la medida (Anexo 12). 
6.3.5.4. Ir al punto 6.3.10. 

6.3.6. Medición no lineal 

6.3.6.1. Seleccionar icono En cadena . 

6.3.6.2. Seguir el perímetro que se desea medir empleando el ratón y realizando varios 
clics como si se deseara realizar una línea punteada. 

6.3.6.3. Dar doble clic derecho y en el menú lateral izquierdo aparecerá la magnitud de 
la medición (Anexo 12). 

6.3.6.4. Ir al punto 6.3.10. 
6.3.7. Medición de un radio 

6.3.7.1. Seleccionar icono Círculo . 

6.3.7.2. Seleccionar la circunferencia del objeto bajo estudio. 
6.3.7.3. Dar doble clic derecho y la medición aparecerá en el menú lateral izquierdo 

(Anexo 12). 
6.3.7.4. Ir al punto 6.3.10. 

6.3.8. Medición de un ángulo 

6.3.8.1. Seleccionar icono Ángulo . 

6.3.8.2. Haciendo uso del ratón de la computadora trazar ambas líneas que delimiten 
el ángulo que se quiera medir. 
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FINAL. 

6.3.8.3. Dar doble clic derecho y visualizar magnitud en el menú lateral izquierdo 
(Anexo 12). 

6.3.8.4. Ir al punto 6.3.10. 
6.3.9. Medición de distancia entre dos rectas 

6.3.9.1. Seleccionar icono Distancia . 

6.3.9.2. Haciendo uso del mouse de la computadora trazar ambas líneas de referencia. 
6.3.9.3. Trazar la línea o líneas entre las rectas que se desea medir. 
6.3.9.4. Dar doble clic derecho y en el menú lateral izquierdo aparecerá la medida 

(Anexo 12). 
6.3.10. Guardar imagen 

6.3.10.1. Seleccionar el ícono Fusión    (Anexo 10) y aceptar la confirmación de 
impresión de objetos visibles. 

6.3.10.2. Cerrar el visualizador y seleccionar “Crear uno nuevo” (Anexo 13). 
6.3.10.3. Guardar en la carpeta creada previamente en “Mis documentos”. 
6.3.10.4. Cerrar el programa IM500. 
6.3.10.5. Apagar el monitor y desconectar de la corriente eléctrica. 

6.4. Limpieza del equipo 
6.4.1. Retirar el objeto de estudio al finalizar la observación. 
6.4.2. Apagar el microscopio con el interruptor de intensidad de luz. 
6.4.3. Eliminar el polvo con un cepillo o paño suave, cuando aplique. 
6.4.4. Limpiar los objetivos y los oculares con paños de limpieza especiales para óptica. De 

requerirse puede empapar con metanol o isopropanol puro. 
6.4.5. Tapar el microscopio con su funda para evitar tener contacto con el polvo. 
6.4.6. Realizar el registro de uso del equipo en la bitácora asignada para el Microscopio 

Leica MZ26 con el formato FOR-SG-008/1 Registro de uso del equipo. 
6.5. Registro en el formato de conocimiento 

6.5.1. Posterior a la lectura del presente documento, llenar el formato FOR-SG-003/1 
Registro de conocimiento de PNO. 

6.5.2. Únicamente se realizará el registro en el formato FOR-SG-007/1 la primera vez que 
se lea el presente documento. 

 
 

7. FORMATOS 

Código de formato Nombre del formato 

FOR-SG-007/1 Registro de conocimiento de PNO 
FOR-SG-008/1 Registro de uso del equipo Microscopio Leica MZ26 

8. REFERENCIA BIBLIOGRÁFICA 
1. FEUM (2018) Suplemento para establecimientos dedicados a la venta y suministro de 

medicamentos y demás insumos para la salud (6 Edición). 
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9. CONTROL DE CAMBIOS 

 

Número de 
cambio 

Realizó Descripción del cambio 

1ª Edición QFB. Jocelyn Sánchez Jiménez Emisión original 

10. DIAGRAMA DE FLUJO 
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11. ANEXOS 
Anexo 1. Componentes del Microscopio Leica 
En el siguiente enlistado se enumeran los componentes del microscopio: 

 
1. Cambiador de aumentos. 
2. Interruptor de aumentos. 
3a. Ajuste de enfoque. 
4. Tornillo de apriete en el soporte del microscopio. 
5. Tornillo de apriete que sujeta el soporte para la cámara 
al portaóptica. 
6. Objetivo intercambiable. 
7. Anteojeras. 
8. Oculares de gran campo para usuarios de gafas. 
9. Tornillos de sujeción. 
10. Soporte para la cámara. 
11. Fototubo. 
12. Cámara. 
13. Lámpara. 
14. Soporte para lámpara. 
15. Interruptor de intensidad de luz de la lámpara. 
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Anexo 2. Colocar objeto a observar. 
 
 

 
Anexo 3. Ajuste de oculares 
Describe como deben utilizarse los oculares dependiendo si el usuario utiliza lentes o no. 

 

A. Si el usuario usa lentes B. Si el usuario no usa lentes C. Ajuste de dioptrías 
 

Anexo 4. Instalación de Cámara. 
1. Desenroscar el tornillo del soporte para la cámara del microscopio Leica DME. 
2. Jalar hacia arriba la cámara adaptada al fototubo del microscopio Leica DME. 
3. Quitar la cámara del fototubo desenroscándolo. 
4. Poner la tapa rosca que se encuentra sobre el fototubo del microscopio Leica MZ6 en el fototubo del 

microscopio Leica DME. 
5. Identificar el soporte para la cámara en el Microscopio Leica MZ6. 
6. Desenroscar el fototubo girando la rosca hacia la derecha. 
7. Jalar el fototubo hacia arriba. 
8. Colocar la cámara en el fototubo del Microscopio Leica MZ6 y fijarla enroscándola en el fototubo. 
9. Colocar el fototubo con la cámara sobre el soporte del Microscopio Leica MZ6. 
10. Enroscar el fototubo girando la rosca hacia la izquierda. 
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Soporte para cámara de microscopio Leica MZ6 Soporte para cámara de microscopio Leica DME 
 

Fototubo de microscopio Leica MZ6 con cámara Fototubo de microscopio Leica DME 
 
 
 
 
 
 
 

 
Fototubo de microscopio Leica DME con tapa rosca. 
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Anexo 5. Archivo > Demo Gallery 
 

Anexo 6. Íconos de llave y medición. 
 

 
 
 

Anexo 7. Ajuste de enfoque. 
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Anexo 8. Adquirir imagen y cerrar ventana. 
 

Anexo 9. Seleccionar aumento. 

 

    Acquire  Cerrar 
ventana 
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Anexo 10. Imagen menú de Medición Pro. 
Esquematiza el menú de las diferentes mediciones que se pueden realizar. 
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Anexo 11. Ventana de parámetros de calibración. 
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Anexo 12. Menú lateral donde se visualiza las medidas realizadas. 
 

Anexo 13. Cerrar visualizador y crear nueva imagen. 
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1. OBJETIVO 
Describir las instrucciones para el uso y manejo adecuado del Biotek (FLx 800). 

2. ALCANCE 
Este documento está dirigido a todas las operaciones que se vayan a realizar con el Bioteck (FLx 
800). 

3. FRECUENCIA 
Deberá emplearse este procedimiento cada vez que se utilice el Biotek (FLx 800). 

4. RESPONSABILIDAD 
La responsabilidad de aplicación y alcance de dicho procedimiento recae sobre todo el personal 
que trabaja con el Biotek (FLx 800) del laboratorio de neuroquímica del Instituto Nacional de 
Neurología y Neurocirugía. 
Es responsabilidad de los encargados de generar recurso humano dar a conocer y verificar que 
este documento sea aplicado. 

5. DEFINICIONES Y SIGLAS 
5.1.  Capacitación: Actividades encaminadas a proporcionar o reforzar conocimientos en el 

personal. 
5.2.  Control de cambios: Conjunto de actividades documentadas que específica los pasos para 

incorporar modificaciones previstas por una oportunidad y/o necesidad. 
5.3.  Copia controlada: Copia emitido por el Sistema de Gestión de calidad, la cual cuenta con un 

sello de la leyenda de “copia controlada” y su ubicación es rastreable. 
5.4. SG: Centro Técnico. 
5.5. Filtro: Dispositivo que permite la absorbancia/transmisión y linealidad en las longitudes de 

onda de las partículas. 
5.6.  Firma de conocimiento: Requisito básico de capacitación, del cual se debe tener un registro 

del personal que se ha informado del PNO, con su firma y fecha en que se le dio a conocer el 
documento. 

5.7. Formato: Hace referencia a la forma como debe ser escrita la información. 
5.8. PNO: Procedimiento normalizado de operación. 
5.9.  Procedimiento normalizado de operación o procedimiento: Documento que contiene las 

instrucciones necesarias para llevar a cabo de manera reproducible una operación. 
5.10.  Rastreabilidad: Capacidad de reconstruir la historia, localización de un elemento o de 

una actividad, por medio de registros de identificación. 
5.11.  Registro: Documento que presenta evidencia de las acciones realizadas para demostrar 

el cumplimiento de actividades o instrucciones. 

Emitió Revisó Autorizó 

 
QFB. Jocelyn Sánchez Jiménez 

Químico Analista 

 
Dr. Javier Aguila Rosas 

Profesor de tiempo completo D 

 
Dr. Camilo Ríos Castañeda 

Profesor asociado D. 
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6. DESARROLLO DEL PROCESO 
6.1. Encendido del Biotek 

6.1.1. Conectar el equipo a la red eléctrica. 

6.1.2. Presionar el interruptor de alimentación ON/OFF que se encuentra en el lado inferior 
derecho de la base, ver Anexo 1. 

Se realizará una prueba del sistema, verificando motores y fuentes de alimentación. Si se 
detecta un error, el lector emitirá un “bip” y mostrará un código de error (Consultar 
manual). Si no se detectan errores, el lector mostrará el mensaje System Self- Test 

 
6.1.3. Después de encender con éxito el FLx800, aparecerá el menú principal: 

6.2. Carga de placa 

Abrir la tapa del lector de microplacas de detección múltiple y colocar la microplaca. 
6.3. Funcionamiento del sistema a través del software Gen5 2.09. 

El equipo Biotek puede trabajar a través del software Gen5 2.09 o de forma manual a través 
del equipo. Si se desea trabajar de forma manual, pasar al punto 6.4. 

6.3.1. Prender el monitor y ejecutar el software Gen5 2.09. 
Nota: Se abrirá automáticamente Task Manager (Administrador de tareas), ver Anexo 2. Se 

puede volver a Task Manager haciendo clic en File > New task o haciendo clic en el 
símbolo  

6.3.2. Seleccionar el acceso que necesite del menú desplegado del lado izquierdo del Task 
Manager 

6.3.3. Para crear un protocolo nuevo seleccionar Read Now / Experiments / Protocols > New. Si 
se utilizara un protocolo o experimento ya existente, seleccionar Experiments / Protocols 
> Open > Seleccionar carpeta o documento. 

 

6.3.4. Editar protocolo en Software Gen5 2.0 

6.3.4.1. Dar clic en Protocol > Procedure o en el símbolo . Ver Anexo 3 y 3.1. 
6.3.4.2. Seleccionar el instrumento que se utilizara (FLx800). 

Nota: Aparecerá una pantalla emergente, donde se podrá editar todo el protocolo/ 
experimento, ver anexo 5. 
Especificar el tipo de placa (Plate Type) y como se leerán los pozos a utilizará, ver anexo 
5.1. 

6.3.4.4. Hacer clic en Read, ver anexo 5.2. 

6.3.4.3. 
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6.3.4.4.1. Escoger un método de detección: fluorescencia o luminiscencia. 
6.3.4.4.2. Indicar el tipo de lectura que se empleará: punto final o escaneo de área (solo 

fluorescencia). 
6.3.4.4.3. Definir el número de conjuntos de filtros de Excitación y Emisión que se utilizaran y 

mantener la posición óptica en la parte superior. 
6.3.4.4.4. Seleccionar el tipo de placa (Full plane). 
6.3.4.4.5. Hacer clic en OK. 

6.3.4.5. Si la edición del protocolo ya está lista, pasar al punto 6.3.4.13. 
Nota: Se puede cambiar el orden de la secuencia de las etapas del procedimiento a ejecutar, 

solo se debe arrastrar y soltar los pasos donde se desea colocar. 
6.3.4.6. Si se pretende incubar hacer clic en Set Temperature y especificar la temperatura 
6.3.4.7. Si se desea poner agitación hacer clic en Shake y seleccionar la intensidad y agitación 

deseada. 
6.3.4.8. Si requiere agregar reactivos durante la rutina, hacer clic en Dispense. 
6.3.4.9. Si necesita realizar un ensayo de cinética, hacer clic en Start Kinetic, para indicar en el 

tiempo e intervalo en cual se realizará la lectura. 
6.3.4.10. Si se desea hacer pausas en el ensayo, hacer clic en Delay y configurar. 
6.3.4.11. Para expulsar o introducir la placa, hacer clic en Plate Out / In. 
6.3.4.12. Si se desea parar o tener un resumen antes de parar el ensayo, seleccionar Stop/ Resume. 
6.3.4.13. Si el ensayo ya está listo, dar clic en Validate > OK, 
6.3.4.14. Definir los requisitos de informe o exportación. 
6.3.4.15. Guardar dando clic en File > Save o Save Protocol As (Dependiendo si se modifica o si se 

creó uno nuevo). 
6.3.4.16. Para ejecutar el ensayo dirigirse al apartado 6.3.6. 

 

6.3.5. Crear curva estándar 

6.3.5.1. Realizar los procedimientos que se necesiten del punto 6.3.4 a 6.3.4.13. 
6.3.5.2. Seleccionar Protocol > Plate Layout o hacer clic en el símbolo . Ver Anexo 6, para 

observar la pantalla de Plate Layout. 
6.3.5.3. Seleccionar Standard Curves, si se desea poner blancos (Blanks) o Muestras Controles 

(Assay Controls), seleccionarlas. 
6.3.5.4. Hacer clic en Next. 

Nota: Si no se seleccionaron Blancos o muestras controles, pasar al punto 6.3.5.7. 
6.3.5.5. Definir el blanco, con nombre, número de réplicas y color que se utilizara en la placa, ver 

Anexo 6.1. 
6.3.5.6. Definir nombre de las muestras control, las réplicas, concentraciones, unidades y color 

que se utilizará en la placa, ver Anexo 6.2. 
6.3.5.7. Establecer el nombre de la curva, las réplicas, concentraciones, unidades y color que se 

utilizara en la placa, ver Anexo 6.3. 
6.3.5.8. Hacer clic en Finish. 
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6.3.5.9. Aparecerá una pantalla, ver Anexo 7, asignar la ubicación de las muestras, los estándares, 
y /o blancos (si corresponde), en los espacios en blanco de la placa que aparece. 

6.3.5.10. Definir los requisitos de informe o exportación. 
6.3.5.11. Hacer clic en ok. 
6.3.5.12. Dirigirse a Protocol >Data Reduction o hacer clic en el símbolo .Ver Anexo 8, para 

observar la pantalla de Data Reduction. 
6.3.5.13. Seleccionar Curve Analysis > Standard Curves. 
6.3.5.14. En la pestaña Data In, seleccionar Y-Axis Data; para ingresar datos en el eje de las Y y 

seleccionar X-Axis Data; para ingresar datos en el eje de las X. Ver anexo 8.1. 
6.3.5.15. En Curve Fit, elegir el modelo matemático a utilizar, ver Anexo 8.2. 
6.3.5.16. Definir en Data Out, las interpolaciones para trazar en la curva, ver Anexo 8.3. 
6.3.5.17. Hacer clic en Aceptar. 
6.3.5.18. Guardar el protocolo usando File > Save / Save Protocol As. 
6.3.5.19. Para ejecutar la curva dirigirse al apartado 6.3.6. 

 
6.3.6. Desarrollo del procedimiento 

6.3.6.1. Seleccionar File > Task o hacer clic en el símbolo 
6.3.6.2. Dar click en Read now. 
6.3.6.3. Escoger el protocolo o documento deseado, con las condiciones en las cuales se realizará 

el ensayo. 
 

6.3.7. Ver resultados 

6.3.7.1. Se pueden ver instantáneamente los resultados de un protocolo /experimento en el 
espacio de trabajo. 

6.3.7.2. Después de leer la placa (o adquirir datos de otro modo), en Plata > View, use la lista 
desplegable Data para mostrar los datos sin procesar y cualquier resultado de reducción 
de datos. Ver anexo 9. 

6.3.7.3. Hacer clic en Edit, junto a un conjunto de datos para personalizar la vista, incluido el 
cambio del formato numérico o la fuente. 

Nota: Las placas de 384 y 1536 pozos, requieren un cambio de tamaño para ver los datos de 
manera efectiva. 

6.3.7.4. Seleccionar la pestaña Statistics, para ver una tabla de resultados de reducción de datos. 
6.3.7.5. Elegir la pestaña Graphs (si está disponible) para ver las curvas estándar. 
6.3.7.6. Hacer clic en el botón Quick Export, para abrir instantáneamente la vista actual en Excel  

6.3.8. Apagar el equipo. 
6.3.8.1. Cerrar el software Gen5 2.09, seleccionando File > Exit > Save (si corresponde). 
6.3.8.2. Apagar la computadora y el monitor. 
6.3.8.3. Apagar el equipo Biotek, presionando el interruptor ON/OFF, que se encuentra en el lado 

inferior derecho de la base. 
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6.3.8.4. Apagar la fuente de energía eléctrica. 
6.3.8.5. Dirigirse al punto 6.7. de este PNO. 

 
6.4. Funcionamiento manual del equipo Biotek 

Para ver la pantalla y panel de control del equipo ver Anexo 10 y 10.1. 
Nota: Cada que se seleccione una opción del equipo, presionar enter, para dirigirse a la siguiente 
pantalla. 

6.4.1. En el menú principal del equipo, ver punto 6.1.3. 
6.4.1.1. Elegir la opción read/leer, cuando se necesite elegir un ensayo predefinido para la lectura 

de placas. Alternativamente, presionar la tecla con la etiqueta READ en el teclado, dirigirse 
al punto 6.4.3. 

6.4.1.2. Seleccionar la opción Define/definir, para crear un nuevo ensayo o modificar uno 
existente. Los parámetros definibles incluyen tipo de ensayo, filtro de excitación, filtro de 
emisión, sensibilidad, identificadores de pocillos, opciones de mapeo de placas, fórmulas 
y parámetros de ajuste de curvas. Dirigirse al apartado 6.4.2 

6.4.1.3. El menú Report/informe, permite imprimir resultados, mapas, ensayos o listas, ver punto 
6.4.3. 

6.4.1.4. Usar la opción UTIL, para ejecutar una prueba del sistem. Se debe establecer varias 
opciones de configuración global, como fecha y hora, salida de informes y preferencias de 
lectura de placas. 

 
6.4.2. Al seleccionar la opción del menú principal DEFINE, 

6.4.2.1. En la pantalla aparecerá Select assay Number, seleccionar número de ensayo. 
Nota: Usar las teclas numéricas para ingresar el número de cualquier ensayo predefinido 

almacenado en la memoria del lector, o la tecla Options para avanzar en un ensayo a la 
vez. 

6.4.2.2. Elegir un ensayo para definir o modificar, luego presione Enter. 
Nota: Puede cambiar el nombre predeterminado del ensayo a uno más descriptivo, utilizar las 

teclas numéricas o alfabéticas. Usar la tecla Options para avanzar los caraSGres 
alfabéticos (A-Z) y presionar Enter para guardar cambios. 

6.4.2.3. Aparecerá otra vez el menú DEFINE, el cual muestra más opciones como: 

6.4.2.3.1. La opción METHOD permite definir el tipo de ensayo (fluorescencia o 
luminiscencia), la geometría de la placa, los filtros de excitación y emisión y la 
configuración de sensibilidad para la adquisición de datos, dirigirse al punto 6.4.2.4. 

6.4.2.3.2. En el menú MAP, especificar el diseño de la placa, usando espacios en blanco, 
controles, estándares y/o muestras, dirigirse al punto 6.4.2.5. 
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Nota: Se puede mapear la placa manualmente o dejar que el software la mapee 
automáticamente. 

6.4.2.3.3. Elegir la opción FORMULA, para definir fórmulas de corte, transformación, 
validación y/o generales, dirigirse al punto 6.4.2.6. 

6.4.2.3.4. Seleccionar la opción CURVE, para especificar un tipo de ajuste de curva y tipos de 
eje x/y. Especificar si los valores atípicos estándar se pueden editar o no, y el método 
por el cual se editará. Se puede habilitar o deshabilitar la función de extrapolación, 
dirigirse al punto 6.4.2.7. 

6.4.2.4. Al seleccionar Define > Method 
6.4.2.4.1. Escoger el tipo de ensayo (Assay type): Fluor para ensayo de fluorescencia o Lumin 

para indicar ensayo de luminiscencia. 
6.4.2.4.2. Definir el tipo de placa (Plate Type), pueden ser 6, 12, 24, seleccione more para 

recorrer las opciones disponibles de  94, 384. 
6.4.2.4.3. Definir la longitud de onda (Wavelength). 

Nota: El FLx800 ofrece la opción de restar automáticamente los resultados del Conjunto 
de filtros n.° 2 de los resultados del Conjunto de filtros n.° 1. 

6.4.2.4.3.1. Seleccionar Single para indicar que no hay resta automática de resultados. Se 
pueden especificar 1, 2 o 3 conjuntos de filtros. 

6.4.2.4.3.2. Usar Dual para indicar al software que sustraiga automáticamente los resultados 
del Conjunto de filtros n.° 2 de los resultados del Conjunto de filtros n.° 1. 

6.4.2.4.4. Seleccionar el conjunto de filtros (Filtersets) 
6.4.2.4.4.1. Ingresar el número de conjunto de filtros (1, 2 o 3) para usar en el ensayo. 
6.4.2.4.4.2. Si se especifican 2 o 3 conjuntos de filtros, se presentará la opción ¿Expulsar entre 

conjuntos? (Eject Between Sets?) 
6.4.2.4.4.2.1. Elegir Yes para expulsar la placa después de cada lectura del conjunto de 

filtros o No para mantener la placa en la cámara para todas las lecturas de 
conjunto de filtros. 

6.4.2.4.4.3. Si se definirá más de un conjunto de filtros para el ensayo, aparecerá la pantalla 
Editar conjunto de filtros (Edit Filtersets). 

6.4.2.4.4.3.1. Elegir 1, 2 o 3 para definir los parámetros. Seleccionar End cuando se 
hayan definido todos los conjuntos de filtro. 

6.4.2.4.5. Seleccionar un valor de filtro de excitación (Excitation Filter) en nanómetros. 
Nota: Cuando se selecciona un filtro, la selección actual se actualiza con el valor del filtro 

y el valor de ancho de banda correspondiente del filtro. 
6.4.2.4.6. Seleccionar un valor de filtro de emisiones (Emission Filter) en nanómetros. 
6.4.2.4.7. Introducir el número de muestras (Samples) a tomar por cada pocillo. 

Nota: El rango válido es de 1 a 255 muestras. 
6.4.2.4.8. Opcional, introducir el retraso antes de las muestras (Delay Before Samples), en 

milisegundos. 
Nota: El rango válido es de 10 a 25550 milisegundos, en incrementos de 10 ms. 
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6.4.2.4.9. Opcional, introducir el retraso entre muestras (Delay Between Samples), en 
milisegundos. 

Nota: El rango válido es de 0 a 25550 milisegundos, en incrementos de 1 ms. 
6.4.2.5. Al seleccionar Define > Map 

6.4.2.5.1. En la pantalla aparecerá Map Generation (Generación de mapas) 
6.4.2.5.1.1. Para indicarle al software que genere automáticamente un mapa de placa 

después de que se hayan definido los espacios en blanco, los controles, los 
estándares y/o las muestras, elegir Auto. 

6.4.2.5.1.2. Seleccionar Manual, para indicar que las asignaciones de pozos se realizarán 
manualmente (por el usuario) en el momento de Definir y/o Ejecutar. 

6.4.2.5.2. Decidir la dirección de mapeo (Mapping Direction) en la placa (hacia abajo / Down 
o transversal / Across). 

6.4.2.5.3. Para comenzar a mapear (Start Mapping), ingresar la ubicación del pozo que será el 
punto de partida para el mapeo automático. 

Nota: Usar las teclas numéricas y alfa para ingresar una letra o un número de ubicación. 
El rango de entrada válido es desde A01 hasta el último pocillo de la placa, según el 
tipo de placa y el número de blancos, estándares, controles y/o muestras definidos 
en el ensayo. 

6.4.2.5.4. Para el mapa del blanco (Blank map), hay varios métodos para elegir: 
 

6.4.2.5.4.1. Escoger Air para realizar una lectura inicial ¨en el aire” justo antes de la lectura 
de la placa y usa esa lectura como el valor en blanco. Este valor se resta de cada 
pocillo de la placa. 

6.4.2.5.4.2. Elegir Full para permitir restar un solo pocillo en blanco o un promedio de 
pocillos en blanco de cada pocillo de la placa. 

6.4.2.5.4.2.1. Ingresar el número de pocillos en blanco en la placa. Usar las teclas 
numéricas para ingresar valor, el rango de entrada válido es de 0 a 48 
pocillos. 

6.4.2.5.4.3. El menú Const permite la entrada de un valor de fluorescencia/luminiscencia 
especificado por el usuario. Este valor se restará de cada pocillo de la placa. 

6.4.2.5.4.3.1. Definir una constante de supresión (Blanking Constant), usar las teclas 
numéricas para ingresar valor, el rango de entrada válido es de 0 a 99999 
unidades relativas de fluorescencia/luminiscencia. 

6.4.2.5.4.4.  Row permite seleccionar un solo pocillo en blanco o un promedio de pocillos en 
blanco para cada fila. Utilice el mapeo manual para colocar espacios en blanco, 
estándares, controles y muestras. 
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6.4.2.5.4.4.1. Ingresar el número de pocillos en blanco en la placa. Usar las teclas 
numéricas para ingresar valor, el rango de entrada válido es de 0 a 48 
pocillos. 

6.4.2.5.4.5. Elegir column para permitir seleccionar un solo pocillo en blanco o un promedio 
de pocillos en blanco para cada columna. 

Nota: El valor en blanco (o promedio) se restará de otros pozos en la columna. Utilice 
el mapeo manual para colocar espacios en blanco, estándares, controles y 
muestras. 

6.4.2.5.4.5.1. Ingresar el número de pocillos en blanco en la placa. Usar las teclas 
numéricas para ingresar valor, el rango de entrada válido es de 0 a 48 
pocillos. 

6.4.2.5.4.6. P-across permite restar un espacio en blanco en cada columna par del pozo a la 
izquierda de cada columna impar. 

Nota: Utilizar el mapeo manual para configurar el mapa apropiado colocando los 
estándares, controles y muestras solo en las columnas impares. 

6.4.2.5.4.7. Elegir p-down para permitir restar un espacio en blanco en las filas B, D, F, H, etc. 
del pozo de arriba en las filas A, C, E, G, etc. 

Nota: Usar el mapeo manual para configurar el mapa apropiado colocando los 
estándares, controles y muestras en las filas A, C, E, G, etc. 

6.4.2.5.4.8. Definir la ubicación de los pocillos en blanco (Blank Location) y seleccionar la 
generación mapa manual (manual map). 

Nota: Usar las teclas numéricas y alfabéticas para ingresar la ubicación del primer pocillo 
en blanco. Pulsar Intro para definir la(s) ubicación(es) subsiguiente(s) de 
pocillos en blanco 

6.4.2.5.5. Para ensayos que requieren estándar, ingrese el número de grupos de estándar 
(Number of standards). 

Nota: Usar las teclas numéricas para ingresar el número de grupos estándar. Ingresar 00 
para indicar que no hay estándares. El rango de entrada válido depende del método 
de ajuste de curva seleccionado. El número máximo de estándares para todos los 
métodos de ajuste de curvas es 12. 

6.4.2.5.6. Ingresar el número de réplicas de estándar (Number of Standard Replicates), si 
aplica, si no, dejar en 01. 

Nota: Usar las teclas numéricas para ingresar el número de réplicas estándar. La entrada 
válida es de 1 a 8 repeticiones. 

6.4.2.5.7. Si la configuración de Número de réplicas estándar es mayor que 01, aparecerá la 
pantalla Average Standards (Estándares promedio) 

6.4.2.5.7.1. Elegir Yes para promediar las réplicas de cada grupo estándar y luego utilice el. 
promedios de grupo al calcular la curva estándar o escoger No para utilizar las 
réplicas estándar individuales al calcular la curva estándar. 
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6.4.2.5.8. Utilizar la pantalla Standard Concentrations (Concentraciones estándar) para 
ingresar el valor de concentración previsto para cada grupo estándar. Si se 
selecciona la generación manual de mapas, también se deben definir las ubicaciones 
de réplica. 

Nota: Usar las teclas numéricas, alfa y decimal para ingresar el estándar. El rango de 
entrada válido es .00001 a 999999. La entrada no puede exceder los 6 caraSGres, 
incluido el punto decimal. 

Nota: Si se selecciona el mapeo automático, la ubicación de cada réplica está disponible 
solo para visualización. Presionar ENTER para avanzar a la entrada del valor de 
concentración para el siguiente estándar. Si se selecciona el mapeo manual, se debe 
definir la ubicación. 

6.4.2.5.9. Después de leer una placa con este ensayo, se puede reutilizar la curva estándar 
(Reuse Standard Curve). Elegir Yes / No 

6.4.2.5.10. Posteriormente de ejecutar el ensayo, calcular los resultados y generar los informes, 
el lector presentará el mensaje Save Standard Curve? ( ¿Guardar curva estándar?). 
Seleccionar Yes / No 

6.4.2.5.11. La próxima vez que se ejecute este ensayo, el lector presentará Standards on Plate? 
(¿Reutilizar la placa almacenada?). Seleccionar Yes / No 

6.4.2.5.12. Para ensayos que requieran controles (Number of Controls), ingrese el número de 
grupos de control. 

Nota: Use las teclas NUMÉRICAS para ingresar el número de grupos de control en el 
ensayo. 

6.4.2.5.13. Seleccionar el tipo de controles (Control Type), las opciones disponibles son: 
Positive Control (PC), Negative Control (NC), High Positive Control (HPC), Low 
Positive Control (LPC), CTL1, CTL2, CTL3, CTL4. Después de elegir un identificador 
para el Control #1, presione Enter para elegir el identificador para el próximo 
control. 

6.4.2.5.14. Ingresar el número de réplicas de control (Number of Control Replicates), si aplica, 
si no, dejar en 01. 

Nota: Usar las teclas numéricas para ingresar el número de réplicas estándar. La entrada 
válida es de 1 a 12 repeticiones. 

6.4.2.5.15. Si el mapeo es manual y los controles están definidos, se deben especificar las 
ubicaciones para cada réplica de control. 

6.4.2.5.16. El número de grupos de muestras en la placa (Number of Samples) se puede definir 
aquí y/o se puede definir en tiempo de ejecución si UTIL > READ > Prompt for 
sample count? está configurado. 

Nota: Usar las teclas numéricas para ingresar el número de grupos de muestras en la 
placa. 

6.4.2.5.17. Después de especificar el número de grupos de muestras, se presenta la pantalla de 
entrada Número de réplicas de muestras (Number of Sample Replicates). 
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6.4.2.5.18. Si el mapeo es manual y las muestras están definidas, se deben especificar las 
ubicaciones para cada réplica de la muestra (Sample Location). 

 
6.4.2.6. Al seleccionar Define > Formula 

6.4.2.6.1. Se pueden admitir 4 tipo de fórmulas 
 

6.4.2.6.1.1. El menú Cutoff nos permite clasificar los resultados. Durante la reducción de 
datos, los resultados se evalúan frente a las fórmulas de corte y a cada pocillo se 
le asigna una etiqueta especificada por el usuario (Pos, Neg o Equiv) 

6.4.2.6.1.2. Elegir Trans para los datos de fluorescencia/luminiscencia en preparación para 
una mayor reducción de datos y/o cálculo de ajuste de curva. 

6.4.2.6.1.3. Escoger Val para determinar si los espacios en blanco y/o los controles son 
válidos. Además, las fórmulas de validación del ensayo se pueden utilizar para 
determinar si todo el ensayo debe considerarse válido o no. 

6.4.2.6.1.4. Seleccionar General después de que se completen todos los demás cálculos, y los 
resultados. 

6.4.2.6.1.5. Utilizar Trans-Var para definir una variable para ser utilizada en fórmulas de 
Trans. 

6.4.2.6.2. Después de seleccionar el tipo de fórmula, aparece la pantalla Entrada de fórmula. 
Cada fórmula puede contener un máximo de 24 caraSGres. Los espacios no son 
necesarios. 

6.4.2.6.3. Consulta el manual del equipo para mayor información. 
 

6.4.2.7. Al seleccionar Define > Curve 
6.4.2.7.1. Ajuste el tipo de curva a utilizar 

6.4.2.7.1.1. Seleccionar None (Ninguno) para realizar una curva estándar. 
6.4.2.7.1.2. Escoger Linear (Lineal) para trazar una linea recta siempre de mejor ajuste 

usando los valores de estándares. 
6.4.2.7.1.3. La opción Quad (Cuadrática) utiliza la ecuación cuadrática “ax2 +bx +c =y” para 

trazar los valores estándar. Utilizando esta curva, cualquier punto de datos para 
un estándar que se desvíe del valor ideal no afectará a toda la curva. 

6.4.2.7.1.4.  Cubic (Cúbica) utiliza la ecuación “ax3 + bx2 + cx + d = y” para trazar los valores 
estándar. 
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Nota: Este tipo de ajuste de curva se ve afectado incluso menos que el ajuste 
cuadrático cuando cualquier estándar en particular tiene un valor bajo. 

6.4.2.7.1.5. Seleccionar 2-P (Logit/Log) para una curva ajustada a los valores estándar, que 
es caraSGrizado por un gráfico sigmoidal sesgado (en forma de S) que 
eventualmente se vuelve asintótico a los valores estándar superior e inferior. La 
ecuación logística se transforma algebraicamente a una forma más simple en la 
que se utilizan valores determinados experimentalmente para las respuestas en 
concentraciones de cero e infinito. 

6.4.2.7.1.6. Escoger C-SPLINE (Cubic-Spline) para una aproximación polinomial por partes 
que consiste en unir un conjunto de puntos de datos mediante una serie de líneas 
rectas, que luego se suavizan mediante un ajuste cúbico. 

6.4.2.7.1.7. Seleccionar 4-P (4-Parameter Logistic) para una curva ajustada a los valores 
estándar, que se caraSGriza por un gráfico sigmoidal sesgado (en forma de S) que 
finalmente se vuelve asintótico a los valores estándar superior e inferior. Los 4 
parámetros son: Asíntota izquierda, Asíntota derecha, Pendiente y Valor en el 
punto de inflexión. Este ajuste es el más recomendado para datos de 
inmunoensayos y es más exacto que Logit/Log. 

6.4.2.7.1.8. Utilizar PT-PT (Point-to-Point) para hacer una gráfica que una cada punto 
estándar con una línea, sin promediar los valores para "suavizar" la curva en cada 
estándar. 

 
6.4.2.7.2. Una vez generada la curva estándar, se pueden excluir uno o más estándares del 

recalculo de la curva (Edit Standard) 
6.4.2.7.2.1. Escoger None / ninguno para suprimir la capacidad de editar valores atípicos 

estándar para este ensayo. 
6.4.2.7.2.2. Seleccionar Manual para habilitar la capacidad 

6.4.2.7.3. Después de seleccionar el tipo de ajuste de curva, seleccione el tipo de eje X/Y (X/Y 
Axis Type). 

Nota: Esta opción no está disponible para los tipos de ajuste de curva 2-P y 4-P 
6.4.2.7.4. Extrapolar la curva (Extrapolation of Unknowns) a para evaluar muestras fuera del 

rango de fluorescencia/ luminiscencia definido por los estándares. Elegir Yes / No 
 

6.4.3. Al seleccionar la opción del menú principal Read. 
6.4.3.1. Aparecerá la pantalla Select Assay Number (Seleccionar número de ensayo). 
6.4.3.2. Seleccionar un ensayo y luego presionar Enter. 
6.4.3.3. Si es necesario, ingrese el Número de muestras, ID de placa y/o ID de muestra. 
6.4.3.4. Ingresar la ubicación de los pocillos. 
6.4.3.5. Colocar la placa en el portador, luego presionar la tecla Read para continuar. 
6.4.3.6. Para detener la lectura en curso, presione la tecla STOP. 
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6.4.4. Al elegir la opción del menú principal Report. 

6.4.4.1. La opción Result permite obtener una copia exacta de los resultados de la lectura de la 
placa (las ocho lecturas de placa recientes se almacenan en la memoria). 

6.4.4.2. Escoger Map para imprimir una matriz que muestra las ubicaciones de los espacios en 
blanco, estándares, controles y muestras para un ensayo en particular. 

6.4.4.3. Seleccionar Assay para imprimir un mapa de placas y una lista de todas las 
configuraciones de un ensayo, como longitudes de onda, números de tipos de pocillos, 
fórmulas y parámetros de ajustes de curvas. 

6.4.4.4. Usar List para imprimir una lista de todos los ensayos (nombre y número) actualmente 
programados en el lector. 

6.4.4.5. Si se genera una curva estándar y si Edit standard outliers (Edición de valores atípicos 
estándar) está establecido en la definición del ensayo Manual, se presenta la opción para 
editar valores atípicos. 

Nota: Seleccionar No para incluir todos los estándares en los cálculos de ajuste de curva. 
Seleccionar Yes para indicar que una o más réplicas o grupos estándar deben excluirse 
temporalmente de los cálculos de ajuste de curva. 

6.4.4.6. Si se seleccionó No, uno o más réplicas estándar se pueden elegir para su exclusión. 
Nota: Elegir Yes para excluir la réplica de los cálculos de ajuste de curva. Elegir No para 

conservar la réplica 
6.4.4.7. Si se seleccionó Yes, uno o más grupos estándar se pueden elegir para su exclusión 

Nota: Escoger Yes para excluir el grupo de los cálculos de ajuste de curva. Escoger No para 
conservar el grupo. 

6.4.4.8. Presionar Enter para avanzar al siguiente grupo. 
 

6.4.5. Al seleccionar la opción del menú principal Util 
6.4.5.1. La opción Setup (configuración) permite editar fecha y hora. 
6.4.5.2. Seleccionar Setup > Output, para especificar la salida de datos y las opciones de 

generación de informes. 

 

Nota: La opción de salida actual se muestra en la línea superior. Seleccionar Print para enviar 
información directamente a una impresora, Computer para enviar datos a través del 
puerto serial, o Both (Ambos). 

6.4.5.3. Presionar Enter 
6.4.6. Finalizadas las operaciones con el equipo Biotek, apagar el equipo y dirigirse al punto 6.5. 
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6.5. Limpieza del equipo 
Limpiar periódicamente todas las superficies expuestas y registrar el uso del equipo en la 
bitácora de Biotek FLx800 con el formato FOR-SG-004/1 que se encuentra a lado. 

 
6.5.1. Limpiar superficies expuestas 

6.5.1.1. Apague y desenchufe el lector 
6.5.1.2. Humedezca un paño de algodón limpio con agua o un detergente suave. 
6.5.1.3. Limpiar el portaplacas y todas las superficies expuestas del instrumento 
6.5.1.4. Si se usó detergente, limpiar todas las superficies con un paño humedecido con agua. 
6.5.1.5. Utilizar un paño limpio y seco para secar todas las superficies mojadas. 

 
6.6. Registro en el Formato de conocimiento 

6.6.1. Posterior a la lectura del presente documento, llenar el formato FOR-SG-003/1 Registro 
de conocimiento de PNO. 

6.6.2. Este formato solo se llenará la primera vez que se lea el presente documento. 
 

FINAL. 
 

7. FORMATOS 

Código de formato Nombre del formato 

FOR-SG-003/1 Registro de conocimiento de PNO´s 

FOR-SG-004/1 Registro de uso del equipo Biotek FLx800 

 
8. CONTROL DE CAMBIOS 

Número de 
cambio 

Realizó Descripción del cambio 

1ª Edición QFB. Jocelyn Sánchez Jiménez Emisión original 

 
9. REFERENCIA BIBLIOGRÁFICA 

9.1. Biotek (2022). Operator’s Manual FLx800TM. Consultado el 29 de enero de 2022. Recuperado de: 
https://manualzz.com/download/26203469. 

9.2. Biotek (2007) Gen5 & Gen5 Secure User’s Guide. Consultado el 18 de enero de 2022. Recuperado 
de: https://lsfequipmentppms.pages.ist.ac.at/wp- 
content/uploads/sites/81/2018/05/Gen5software.pdf 

https://lsfequipmentppms.pages.ist.ac.at/wp-content/uploads/sites/81/2018/05/Gen5software.pdf
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10. Diagrama de flujo 
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11. ANEXOS. 
Anexo 1. Componentes externos del Biotek FLx800 
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Anexo 2. Administrador de tareas (task manager) 

 
 

Anexo 3. Pantalla principal software Gen5 2.09 
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1. Protocol 
Dirigirse al anexo 3.1. Para ver el espacio de trabajo de protocolo 

2. Árbol de menú 
El árbol de menús, anclado en el lado izquierdo del espacio de trabajo, ofrece una alternativa al 
uso de las barras de herramientas y los menús. 

3. Barra de herramientas y menús 
4. Vista de la placa 

Proporciona una vista o espacio de trabajo para cada placa procesada (o por procesar) en un 
experimento. 

 
 
 

Anexo 3.1. Espacio de trabajo de protocolo 

Cuando se crea un nuevo protocolo, el software abre un espacio de trabajo limitado a los componentes 
del protocolo. 
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El espacio de trabajo está compuesto por el árbol de menús con una rama para cada uno de los 
elementos del protocolo. El orden de los elementos del protocolo refleja el orden a seguir al definir la 

mayoría de los protocolos. 
 

Definir el procedimiento o leer los parámetros, como el método de detección, la longitud de 
onda y otros factores, es el paso más importante para Gen5. El procedimiento describe los 
conjuntos de datos que se utilizan en la mayoría de los pasos posteriores para generar la salida 

de resultados. El diseño de placa es el único otro elemento del protocolo que no se ve afectado por el 
procedimiento, se ve afectado por el tamaño de placa seleccionado. 

 
Para la mayoría de los protocolos, es mejor definir el diseño de la placa en el segundo paso. 
Gen5 realizará automáticamente un cálculo de sustracción de espacios en blanco cuando los 
espacios en blanco están definidos en el diseño de placa. Definir los estándares y sus 

concentraciones en el diseño de la placa es un requisito previo para generar una curva estándar. 
 

La reducción de datos es una de las funciones más potentes de Gen5 y requiere la información 
proporcionada por los dos pasos anteriores para ofrecer de forma lógica sus capacidades. Las 
transformaciones generadas automáticamente, como la corrección de la trayectoria y la 
capacidad de realizar análisis de pozos. Para trazar una curva estándar o de título y validar las 
fórmulas de transformación se requiere conocer el diseño de la placa. 

 
Report/Export Builders es una herramienta para seleccionar y personalizar la apariencia de 
conjuntos de datos que luego están disponibles para imprimir o exportar. 
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Anexo 4. Botones e iconos. 
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Anexo 5. Procedure - Editor de protocolos. 

 
Anexo 5.1. Tipo de placa 
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Anexo 5.2. Read Step 

 

 
Anexo 6. Plate Layout Wizard 
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Anexo 6.1. Blanco 

 
Anexo 6.2. Muestras control 
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Anexo 6.3. Curva 

 

Anexo 7. Placa para seleccionar Blancos, muestras control y muestras  
Utilizar las herramientas de 
asignación de serie , 
para asignar rápidamente 
replicas al diseño de la placa 
en una línea horizontal o 
vertical. Seleccione una de las 
direcciones (alternar para 
acceder a horizontal o 
vertical) y luego haga clic o 
arrastre en el diseño de la 
placa. 
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Anexo 8. Data Reduction 

 
Anexo 8.1 Data In 
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Anexo 8.2. Curve Fit 

 
 
 

Anexo 8.3. Data Out 



Procedimiento Normalizado de Operación para uso y manejo 
del Biotek FLx800 

Página 27 de 29 PNO-SG-01/1 

Anexo 4 
Anexo 2 
 

 

 

Código: PNO-SG-01  Departamento emisor: CENTRO TÉCNICO 1ª Edición 

Fecha de Emisión: 11-Abr-22 Fecha de Revisión: 15-Abr-22 Fecha de autorización: 15-Abr-22 

Próxima revisión: 22-Abr-22 Fecha de aplicación: Oct-25 

 
 

Anexo 9. Vista de la placa para ver resultados 
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Anexo 10. Pantalla y panel de control 

El equipo cuenta con la siguiente pantalla y panel de control. A través de esta interfaz, puede crear y 
modificar ensayos de fluorescencia y luminiscencia, leer placas, almacenar e imprimir resultados, 
enviar resultados a una computadora externa y más. 

 

 
Anexo 10.1 Teclado del panel de control 

 
El teclado tiene cuatro teclas programables, una debajo de cada opción de menú 
seleccionable. 
Presione una tecla programable para hacer una selección. Por ejemplo, desde el 
menú principal, presionar la tecla programable más a la izquierda para seleccionar 
LEER, la más a la derecha para seleccionar UTIL. 
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Salga de la pantalla actual y regrese al Menú principal. 
Al pulsar Menú principal muestras se define o modifica un ensayo, se guarda 
automáticamente la configuración actual. 

 
Recorra las opciones disponibles dentro de una pantalla. Por ejemplo, presione 
Opciones dentro de la pantalla Seleccionar número de ensayo para recorrer los 
nombres de los ensayos integrados. 

 
Presionar ENTER generalmente guarda la configuración actual de la pantalla y 
avanza a la siguiente pantalla de una serie. 

 
Presionar Pantalla anterior generalmente guarda la configuración actual de la 
pantalla y devuelve el control a la pantalla más vista anteriormente. 

 
Presionar CLEAR para restablecer un valor numérico a 0 o para borrar todos los 
caraSGres al editar el nombre de un ensayo. Sugerencia: Presionar Shift + Clear en 
la pantalla Generación de mapas para “borrar” un mapa manual definido 
previamente. 

          Mueva el cursor hacia la izquierda en las pantallas de entrada de datos. 

         Mueva el cursor a la derecha en las pantallas de entrada de datos. 

Inicie una lectura de placa 
 
 

Detener la lectura actualmente en curso 
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1. OBJETIVO 
Describir las instrucciones para el uso y manejo adecuado del Espectrofotómetro de Absorción 
Atómica – AAnalyst600. 

2. ALCANCE 
Este documento está dirigido a todas las operaciones que se realicen con el Espectrofotómetro de 
Absorción Atómica. 

3. FRECUENCIA 
Deberá emplearse este procedimiento cada vez que se utilice el Espectrofotómetro de Absorción 
Atómica. 

4. RESPONSABILIDAD 
La responsabilidad de aplicación y alcance de dicho procedimiento recae sobre todo el personal 
que trabaja con el Espectrofotómetro de Absorción Atómica del laboratorio de neuroquímica del 
Instituto Nacional de Neurología y Neurocirugía. 
Es responsabilidad de los encargados de generar recurso humano dar a conocer y verificar que 
este documento sea aplicado. 

5. DEFINICIONES Y SIGLAS 
5.1.  Capacitación: actividades encaminadas a proporcionar o reforzar conocimientos en el 

personal. 
5.2.  Control de cambios: Conjunto de actividades documentadas que específica los pasos para 

incorporar modificaciones previstas por una oportunidad y/o necesidad. 
5.3.  Copia controlada: Copia emitido por el Sistema de Gestión de calidad, la cual cuenta con un 

sello de la leyenda de “copia controlada” y su ubicación es rastreable. 
5.4. SG: Centro Técnico. 
5.5.  Firma de conocimiento: Requisito básico de capacitación, del cual se debe tener un registro del 

personal que se ha informado del PNO, con su firma y fecha en que se le dio a conocer el 
documento. 

5.6. Formato: Hace referencia a la forma como debe ser escrita la información. 
5.7. Lámpara EDL: Lámparas de descarga sin electrodos codificadas. 
5.8. Lámpara HCL: Lámparas de cátodo hueco. 
5.9. PNO: Procedimiento normalizado de operación. 

5.10.  Procedimiento normalizado de operación o procedimiento: Documento que contiene 
las instrucciones necesarias para llevar a cabo de manera reproducible una operación. 

5.11. Rastreabilidad: Capacidad de reconstruir la historia, localización de un elemento. 
5.12.  Registro: Documento que presenta evidencia de las acciones realizadas para demostrar 

el cumplimiento de actividades o instrucciones. 

Emitió Revisó Autorizó 

 
QFB. Jocelyn Sánchez Jiménez 

Químico Analista 

 
Dr. Javier Aguila Rosas 

Profesor de tiempo completo D 

 
Dr. Camilo Ríos Castañeda 

Profesor asociado D  
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6. DESARROLLO DEL PROCESO 
6.1. Encendido del sistema 

6.1.1. Comprobar que el sistema del espectrofotómetro y otros instrumentos auxiliares estén 
instalados y conectados correctamente a sus fuentes de energía. Verificar que las 
mangueras de refrigerantes estén conectadas correctamente al espectrofotómetro. 

Nota: Si es necesario verificar las presiones para el gas del quemador (Anexo 1) y para los 
gases del horno (Anexo 2). 

6.1.2. Presionar el interruptor de la caja de corriente superior (botón verde) y del controlador 
de voltaje inferior (botón on/off). 

6.1.3. Verificar que el interruptor del sistema de enfriamiento esté encendido. 
6.1.4. Encender el sistema de ventilación de vapores para el área de trabajo (botón negro). 
6.1.5. Encender el sistema del espectrofotómetro con el interruptor operacional de 

encendido/apagado en el panel frontal. 
6.1.6. Encender la computadora y el monitor. 
6.1.7. Instalar o conectar la lámpara de cátodo en el soporte del compartimento de la lámpara 

correspondiente, dirigirse al punto 6.2. 
6.1.8. En la computadora, ingresar al software WinLab32 AA, hacer doble clic en el icono 

WinLab32 for AA y dirigirse al apartado 6.3. 
6.1.9. Colocar las soluciones de las muestras en el automuestreador. 

 
6.2. Instalación de las lámparas 

6.2.1. Instalación y conexión de las lámparas HCL 

6.2.1.1. Abrir la cubierta del comportamiento de lámparas, ubicado del lado izquierdo del 
automuestreador. 

6.2.1.2. Deslizar la lámpara de Lumina HCL (posición 1-8) hacia el elemento requerido dentro del 
soporte de lámpara seleccionada y cerciorarse de que el tomacorriente integrado se 
deslice completamente sobre el enchufe en el soporte de la lámpara. 

6.2.1.3. Conectar cada lámpara al tomacorriente que marca el mismo número que el soporte de la 
lámpara. 

6.2.1.4. Cerrar la cubierta del compartimiento de la lámpara. 
6.2.1.5. Dirigirse al punto 6.3. de este manual. 

6.2.2. Instalación de las lámparas EDL 

6.2.2.1. Abrir la cubierta del compartimento de lámpara. 
6.2.2.2. Utilizar los soportes de lámparas numeradas del 1 al 4 para las EDL. 
6.2.2.3. Si es necesario, ensamblar la lámpara al deslizar el controlador de la lámpara por la manga 

de la lámpara para el elemento requerido. Oprimir el pasador de bloqueo cuando la manga 
se desliza a su lugar y asegurar de que el pasador de bloqueo se extiende a través del 
hueco de ubicación en la manga. 

6.2.2.4. Deslizar cuidadosamente la lámpara al soporte de la lámpara hasta que encaje con el 
extremo final del soporte. 
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6.2.2.5. Insertar el enchufe de codificación sobre el tomacorriente en el soporte de la lámpara. 
6.2.2.6. Insertar el conector de la lámpara en él toma correcto de EDL a mano izquierda del 

compartimiento de la lámpara. Utilizar el receptor que tiene el mismo número que el 
soporte de la lámpara, ver Anexo 3.1. 

6.2.2.7. Cerrar la cubierta del compartimiento de la lámpara. 
6.2.2.8. Dirigirse al punto 8.3. de este manual. 

6.2.3. Extracción de la lámpara 

6.2.3.1. No desconectar ni extraer las lámparas mientras están encendidas. 
6.2.3.2. En el Software WinLab32 AA, la barra de herramientas hacer clic en “lámparas” (Lamps). 

Aparecerá la ventana de ajuste de lámparas (Lamp setup). 
6.2.3.3. Comprobar que la lámpara que requiera extraer se encuentre apagada. 

Nota: El botón de encendido (On) deberá de estar en color gris. Si fuera necesario, haga clic en 
el botón de encendido (On) respectivo. 

6.2.3.4. Cerrar la ventana. 
6.2.3.5. Desconectar y extraer la lámpara. Para las EDL, extraer también el enchufe de 

codificación. 
Nota: No tocar la ventana frontal de la lámpara; el sudor u otra contaminación puede reducir 

la intensidad de la radiación. 
 

6.3. Software WinLab32 AA 

Una vez iniciado   el software realizará un diagnóstico   de la   conectividad del sistema: 
espectrofotómetro, automuestreador y horno. 
Nota: Si alguno de estos se marcara en color rojo, dirigirse a Tools > Diagnostics, seleccionar en la parte 
inferior el sistema en el que hubo un error y dar clic en Reconnect. 

6.3.1. Crear un método 
6.3.1.1. Hacer clic en el menú File > New > Method. 
6.3.1.2. Aparecerá la pantalla de Method Editor, definir los parámetros que se utilizarán en el 

método, ver Anexo 4.1.1. 
6.3.1.2.1. En el menú Spectrometer, 

6.3.1.2.1.1. En la pestaña lateral Define Elements 
Definir el elemento, la longitud de onda (nm) y el tipo de señal, con el cual se desea 

trabajar. 
6.3.1.2.1.2. Hacer clic en la pestaña lateral Settings. 

Definir en Read Parameters (parámetros de lectura), el tiempo, el tiempo de retardo y el 
número de réplicas. 

 
6.3.1.2.2. Hacer clic en el menú Sampler, para configurar condiciones del método. 

6.3.1.2.2.1. En la pestaña lateral Furnace program 
Definir la temperatura (°C), el tiempo de rampa (Ramp Time), el tiempo de 

mantenimiento (Hold Time), el flujo (International Flow) y el tipo de gas (Gas type). 
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De igual manera definir en qué etapa se va a leer, la temperatura de inyección y si se 
realizara una limpieza adicional al horno. 

6.3.1.2.2.2. Hacer clic en la pestaña lateral Autosampler (automuestreador). 
Definir el volumen a inyectar (μL), el volumen de dilución (μL) y en qué posición se 

encontrará (si aplica). Si se utilizan modificadores de matriz (Matrix modificare), 
indicar el volumen (μL) y en qué posición se encontrarán. 

6.3.1.2.2.3. Hacer clic en la pestaña lateral Sequence 
Utilizar esta pestaña para configurar el orden en cual se utilizará el horno y 

automuestreador. 
 

6.3.1.2.3. Hacer clic en el menú Calibration. 
6.3.1.2.3.1. En la pestaña lateral Equation and Units 

Seleccionar la ecuación que se utilizara: lineal (Linear), lineal a cero (Linear-thru-zeru) 
o no lineal (Non-linear) y seleccionar las unidades en las que se trabajara. 

6.3.1.2.3.2. Hacer clic en la pestaña lateral Standard Concentrations 
Definir el nombre de los estándares en ID, las concentraciones, en qué posición del 

automuestreador estarán, la concentración de stock (uL) y la concentración de 
dilución (uL) 

6.3.1.2.3.3. Hacer clic en la pestaña lateral Initial Calibration 
Utilizar esta pestaña para decidir si crear una nueva calibración usando soluciones 

estándar y en blanco, o usar una calibración que ha sido almacenada. 
6.3.1.2.3.4. Hacer clic en la pestaña lateral Calibration check 

Utilizar esta pestaña para revisar la calibración, modificar el coeficiente de correlación 
o las repeticiones. 

6.3.1.2.3.5. Hacer clic en la pestaña lateral Recalibration 
Utilizar esta pestaña para editar la recalibración. 

 
6.3.1.2.4. Hacer clic en el menú Checks 

Utilizar esta página para configurar la precisión y la recuperación automática del método. 
 

6.3.1.2.5. Hacer clic en el menú OK 
Utilizar la página de control de calidad para introducir parámetros que describen las 

muestras. Se utilizan para realizar comprobaciones en tiempo de ejecución del 
rendimiento del instrumento. Usted programa cuándo y en qué condiciones se 
analizarán las muestras de control de calidad. 

 
6.3.1.2.6. Hacer clic el menú Options. 

Utilizar las entradas en la página de opciones para configurar la visualización de resultados 
y el registro impreso. También establecer algunas opciones para que la información se 
almacene con un conjunto de datos de resultados para un análisis. 
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6.3.1.3.  Si se necesita almacenar información sobre las muestras, en la barra de herramientas 
hacer clic en SamInfo o en el menú Tools, hacer clic en Sample Information Editor, ver 
Anexo 4.1.2. 

Definir la localización de la muestra en la que se encuentra en el automuestreador, ingresar 
ID de la muestra, blanco o estándares e ingresar las concentraciones correspondientes. 

6.3.1.4. Una vez definido el método, dirigirse al punto 6.3.4. 
 

6.3.2. Abrir un método existente 
6.3.2.1. Hacer clic en el menú File >Open > Method, o en menú Tools > Method Editor, o bien en la 

barra de herramientas, hacer clic en el icono MethEd. 
6.3.2.2. Aparecerá un cuadro de diálogo Open Method (Abrir método), seleccionar el método que 

desee y hacer clic en OK. Si el método que desea está almacenado en una biblioteca de 
métodos diferente, hacer clic en Browse (navegar) y seleccionar la ubicación correcta. Volver 
al cuadro de diálogo Open Method (Abrir método) y seleccionar el método deseado. 

6.3.3. Método asociado con un conjunto de datos de resultados almacenados 
6.3.3.1. En el menú File, hacer clic en Import from Results Library (Importar desde biblioteca de 

resultados) 
6.3.3.2. Seleccionar el conjunto de datos de resultados y hacer clic en Ok. 
6.3.3.3. Aparecerá el cuadro de diálogo Import from Results Library, seleccionar el método que 

desea importar) y dar clic en Ok. 
6.3.3.4. Utilizar este método para su análisis sin modificaciones si lo desea. Para cambiar los 

parámetros de este método, consulte Editor de métodos en la siguiente sección. 
6.3.3.5. Para guardar este método en una biblioteca de métodos, utilice el menú File > Save o Save 

As. 
 

6.3.4. Ejecución del análisis 
6.3.4.1. Sep Lamp /Configuración de la lámpara 
6.3.4.1.1. Hacer clic en el símbolo Lamps, para encender o apagar la lámpara hacer clic en el 

botón On / Off de la lámpara del elemento que se necesite para el análisis, ver Anexo 
Anexo 4.1.3. 

Nota: Cuando el botón está en verde, la lámpara está encendida. 
6.3.4.1.2. Hacer clic en botón Apply. 

 
6.3.5. Ventana para el controlar los análisis 

6.3.5.1. Automated Analysis Control /Ventana de control de análisis automatizado 

Cuando desee realizar un análisis automatizado (la aplicación ejecuta blancos, estándares y 
muestras en un orden predefinido), utilizar esta opción para controlar el sistema y el 
muestreador automático, ver Anexo 4.2.1. 

6.3.5.1.1. Para mostrar esta ventana, en la barra de herramientas, hacer clic en Auto o en el menú 
Tools, hacer clic en Automated Analysis Control. 

6.3.5.1.2. Menú Set Up 
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Esta página define los métodos y los archivos de información de muestras que se 
utilizarán, dónde almacenar los datos analíticos y otros parámetros de 
configuración, como la recalibración de la longitud de onda, el apagado automático 
de la lámpara y la exportación automática. Esta pestaña no es requerimiento. 

6.3.5.1.3. Hacer clic en el menú Analyze 
Esta página indica el estado del análisis del instrumento, controla el instrumento y 

automuestreador y contiene opciones para iniciar y detener un análisis. 
Nota: Esta pantalla muestra cuanto del análisis (porcentaje completo) se ha realizado para 

la muestra actual y muestra cuando se ha realizado del análisis completo 
(porcentaje completo) 

6.3.5.1.4. Si no se ha definido en SamInfo, ingresar ID en el archivo de información para identificar 
si es un blanco, estándar de calibración o muestra de control y definir la localización en 
la que se encuentran en el automuestreador. 

6.3.5.1.5. Hacer clic en el botón superior Analyze All, si se desea analizar todas las muestras en la 
secuencia analítica. 

6.3.5.1.6. Para interrumpir la secuencia de análisis, hacer clic nuevamente en Analyze All. 
Aparecerá un cuadro de dialogo The stopping an analytical Sequence (Detener la 
secuencia analítica), de modo que puede seleccionar cuando se detendrá el análisis. 

6.3.5.1.7. Hacer clic en el botón superior Calibrate, si se desea iniciar la secuencia de calibración. 
El sistema utiliza el blanco y los estándares definidos en el método. 

6.3.5.1.8. Para interrumpir la secuencia de calibración, haga clic nuevamente en Calibrate. 
Aparecerá el cuadro de diálogo The stopping an analytical Sequence (Deteniendo una 
secuencia analítica), para que pueda seleccionar cuándo se detendrá el análisis, puede 
reanudar en un lugar particular de la secuencia de calibración haciendo clic nuevamente 
en Calibrate. Aparece el cuadro de diálogo Continuing an Analytical Sequence (Continuar 
una secuencia analítica), para que pueda seleccionar el punto en el que se reiniciará el 
análisis interrumpido. 

6.3.5.1.9. Hacer clic en el botón superior Analyze Samples, si se desea analizar muestras después 
de calibrar el instrumento. 

6.3.5.1.10. Para detener los análisis, hacer clic en el botón Analyze Samples. Aparecerá un cuadro 
de diálogo The stopping an analytical Sequence (Deteniendo una secuencia analítica), 
para que pueda seleccionar cuándo se detendrá el análisis de la muestra. 

6.3.5.1.11. Hacer clic en el botón superior Reset sequence, si se desea restablecer la secuencia 
analítica al principio. La próxima vez que haga clic en Analyze All, Analyze Samples o 
Calibrate la secuencia se reconstruirá y el sistema comenzará con el primer elemento de 
la lista 

6.3.5.1.12. En la parte inferior en Method, se puede ver que método se está utilizando para el 
análisis actual. En Rebuild List, puede actualizar la pantalla (para mostrar los cambios 
que se han realizado). En Print List, puede imprimir la información de secuencia, 
ubicación, tipo de muestra, ID y el estado que se muestra. En Priority, puede insertar una 
nueva muestra en la secuencia (solo durante un análisis). 
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6.3.6. Data Reprocessing / Ventana de reprocesamiento de datos 
Utilizar esta ventana para reprocesar datos de muestra que se almacenan en un conjunto de 

datos de resultados, ver Anexo 4.2.2. 
6.3.6.1. Para mostrar esta ventana, en la barra de herramientas, hacer clic en Reproc o en el menú 

Tools, hacer clic en Data Reprocessin. 
6.3.6.2. Hacer clic en Browse y seleccionar un conjunto de datos de resultados que contiene los 

datos que desea reprocesar. 
6.3.6.3.  Los resultados de los datos reprocesados se guardarán en el conjunto de datos que se 

muestra en el campo de entrada. 
6.3.6.4. En la tabla, revisar la información. Los ID en el conjunto de datos de resultados 

seleccionados se enumeran junto con la información de la muestra que se usó cuando se 
recopilaron los datos originalmente. Para editar esta información, escriba la nueva 
información en los campos según lo desee. 

6.3.6.5. Hacer clic en Reprocess. 
 

6.3.7. Furnace Control / Control de Horno 
Utilizar esta ventana para controlar el horno, acondicionar el tubo de grafito y alinear el 

inyector automático. Solo puede utilizar estos controles cuando no hay ningún análisis en 
curso. El estado del horno y el programa del horno se muestran en la parte superior de 
esta ventana, ver Anexo 4.2.3. 

6.3.7.1. Para mostrar esta ventana, en la barra de herramientas, hacer clic en Furnace o en el menú 
Tools, hacer clic en Furnace Control. 

6.3.7.2. Se encenderá el botón de Furnace On/Off cuando se esté utilizando el horno. Presionar 
para Iniciar o detener el programa del horno previamente definido en el método activo. 

6.3.7.3. Seleccionar Go To Next Step si se desea detener el paso actual del programa del horno y 
comenzar el siguiente paso en el programa. 

6.3.7.4. Para calentar el horno a una temperatura seleccionada en Cleanout Temp, ingresar la 
temperatura, luego haga clic en Start 

6.3.7.5. Seleccionar Open/Close cuando se quiera abrir o cerrar el horno liberando o activando la 
presión neumática que mantiene cerrado el horno. Si el horno está abierto, antes de poder 
utilizar el sistema, debe hacer clic en Abrir/Cerrar para cerrar el horno. 

6.3.7.6. Seleccionar Align Tip para alinear la punta de la pipeta del inyector automático que utiliza en 
el horno. 

6.3.7.7. Seleccionar Condition Tube para Iniciar o detener el programa de horno especial que 
calienta el horno a temperaturas cada vez más altas para acondicionar el tubo de grafito. 

6.3.7.8. Muestreador de descarga 
6.3.7.9. Seleccionar Flush Sampler para Iniciar o detener una serie de pasos de lavado del inyector 

automático que enjuaga la pipeta del inyector automático del horno. Haga esto cuando 
rellene la botella de enjuague o cambie cualquiera de los tubos del sistema de enjuague. 
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6.3.8. Ventanas de visualización de información 
6.3.8.1. Peaks Display / Ventana de visualización de picos 

Esta ventana muestra los espectros de analitos por muestra generados a partir del análisis o 
reprocesados a partir de los datos almacenados, ver Anexo 4.3.1. 

6.3.8.1.1. Para mostrar esta ventana, en la barra de herramientas, hacer clic en Peaks. 
 

6.3.8.2. Results Display / Ventana de visualización de resultados 
Esta ventana muestra las mediciones realizadas en las muestras actuales, como los valores de 

concentración calculados y la información estadística, ver Anexo 4.3.2. 
6.3.8.2.1. Para mostrar esta ventana, en la barra de herramientas, hacer clic en Results o en el 

menú Tools, hacer clic en Results. 
 

6.3.8.3. Calibration Display / Ventana de visualización de calibración 
Esta ventana muestra la calibración activa a medida que se genera y cuando el sistema la 

utiliza. Si esta ventana está vacía, no hay una curva de calibración activa, ver Anexo 4.3.3. 
6.3.8.3.1. Para mostrar esta ventana, en la barra de herramientas, hacer clic en Calib o en el menú 

Tools, hacer clic en Calibration. 
 

6.3.8.4. Examinación espectral MSF (Multicomponent Spectral Fitting / Ajuste Espectral 
Multicomponente) 

Utilizar este modelo matemático para distinguir los espectros de analitos de los espectros de 
interferencia, mejorar los límites de detección y la precisión. 

Ver anexo 4.3.4 para observar la ventana de MSF 
6.3.8.4.1. Para mostrar esta ventana, en la barra de herramientas, hacer clic en Examine o en el 

menú Tools, hacer clic en Examine/MSF. 
6.3.8.4.2. Hacer clic en menú Data y luego hacer clic en Data Set. 
6.3.8.4.3. Aparecerá la ventana Data Selection Wizard seleccionar el archivo que se necesite. 
6.3.8.4.4. Seleccionar los resultados de las muestras y el análisis a utilizar. 
6.3.8.4.5. Hacer clic en Finish 
6.3.8.4.6. La ventana Examine Spectra, mostrará la muestra o analito seleccionado. 

 
6.4. Apagado del sistema 

6.4.1. Apagado del horno 

6.4.1.1. Descargar el sistema de enjuague de automuestreador. 
6.4.1.2. Apagar los gases del horno al espectrofotómetro desde su fuente. 

6.4.2. Apagado del espectrofotómetro 

6.4.2.1. Salir del Software WinLab32 AA. En File, seleccionar Exit 
6.4.2.2. Apagar el espectrofotómetro en el interruptor de on/off (encendido/apagado) del panel 

frontal. 
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6.4.2.3. Apagar todos los accesorios. 
6.4.2.4. Si ya no se va a utilizar la computadora ni la impresora para otras tareas, apagarlas como 

se describe en sus respectivas guías del usuario. 
6.4.2.5. Vaciar el contenedor del desagüe del quemador. 
6.4.2.6. Vaciar la botella de desechos del automuestraeador. 
6.4.2.7. Registrar el uso del equipo en la bitácora del Espectrofotómetro de Absorbancia Atómica 

– Aanalyst 600 con el formato FOR-SG-004/1 que se encuentra a lado. 
6.5.Registro en el Formato de conocimiento 

6.5.1. Posterior a la lectura del presente documento, llenar el formato FOR-SG-003/1 Registro 
de conocimiento de PNO. 

6.5.2. Este formato solo se llenará la primera vez que se lea el presente documento. 
FINAL. 

 
7. FORMATOS 

Código de formato Nombre del formato 

FOR-SG-003/1 Registro de conocimiento de PNO´s 

FOR-SG-004/1 
Registro de uso del equipo Espectrofotómetro de Absorbancia 
Atómica - AAnalyst 600 
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8.3. Perkin Elmer. (1999). AAnalyst 800 Atomic Absorption Spectrometer User Guide. 

9. CONTROL DE CAMBIOS 

Número de 
cambio 

Realizó Descripción del cambio 

1ª Edición Q.F.B. Jocelyn Sánchez Jiménez Emisión original 
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10. DIAGRAMA DE FLUJO 

 
11. ANEXOS. 

Anexo 1. Presiones requeridas para los gases del quemador 
 

Gas Presión manométrica de salida 
kpa bar psig 

Pmin Pmax Pmin Pmax Pmin Pmax 

Acetileno (C2H2) 90 100 0,9 1,0 13,0 14,5 
Aire 450 500 4,5 5,0 65,0 72,5 

Óxido nitroso (N2O) 450 500 4,5 5,0 65,0 72,5 

 
● Fijar la presión de salida de manómetro para cada fase para un valor justo por debajo del valor 

(Pmas). 
● Fijar siempre la misma presión de salida de manómetro para aire y óxido nitroso. 
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Sockets para EDL 
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● Nunca ajustar la presión manométrica a salida a un valor superior a la presión máxima (Pmas). 
● Siempre abra el suministro de aire ya que se requiere presión de aire para el sistema neumático 

del espectrómetro. 
 

Anexo 2. Presiones requeridas para los gases del horno 
 

Gas Presión manométrica de salida 
kpa bar psig 

Pmin Pmax Pmin Pmax Pmin Pmax 

Argón 350 400 3.5 4.0 50.0 58.0 
Nitrógeno 350 400 3.5 4.0 50.0 58.0 
Especial 350 400 3.5 4.0 50.0 58.0 

 
● Establecer la presión manométrica de salida para cada gas en un valor justo por debajo del valor 

máximo (Pmas). 
● Nunca ajustar la presión manométrica a salida a un valor superior a la presión máxima (Pmas). 

 
Anexo 3. Lámpara. 

 

 
Anexo 3.1. Lámpara. EDL 

 
 

Sockets para EDL 
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Anexo 4. Descripción general de Windows para análisis y control de datos 

Anexo 4.1. Editores especializados para entrada de parámetros. 

Anexo 4.1.1. Method Editor / Editor de métodos 
 

Ingresar toda la información analítica necesaria para realizar un 
análisis, donde se encuentran los parámetros para la configuración 
del instrumento, instrucciones para convertir datos espectrales en 
datos de intensidad, información de calibración y configuración del 
muestreador automático, concentraciones de picos para verificación 
de matriz de muestras, ubicación de soluciones de control de calidad 
y las opciones de imprimir y almacenar datos. 

 
 
 

Anexo 4.1.2. Sample Information Editor /Editor de la información de muestra 
 
 
 

Utilizar esta ventana para ingresar toda la información relativa a 
sus muestras. Información para describir las muestras, el cómo se 
preparó y como se estableció un programa de análisis. 

 
 
 
 

Anexo 4.1.3. Lamp Sep / Configuración de la lámpara 
 
 
 
 

Utilizar esta ventana para configurar las lámparas que utilizará 
para el análisis. 
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Anexo 4.2. Ventana para el controlar los análisis 
Anexo 4.2.1. Automated Analysis Control /Control de análisis automatizado 

 
 
 
 

Para análisis con muchas muestras o cuando se utiliza un 
muestreador automático, se puede configurar un análisis 
automatizado. 

 
 
 
 
 

Anexo 4.2.2. Data Reprocessing / Procesamiento de datos 
 
 

Utilizar esta ventana para volver a calcular los datos en un conjunto 
de datos de resultados. 
Es útil si se desea configurar condiciones analíticas diferentes a las 
de la fase inicial, seleccionar diferentes parámetros de pico, o 
cambiar o corregir los parámetros del método sin la necesidad de 
volver a analizar la muestra. 

 
 
 
 

Anexo 4.2.3. Furnace Control /Control del horno 
 
 
 
 
 
 

Utilizar esta ventana para controlar el horno, acondicionar el tubo 
de grafito y alinear el inyector automático. 
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Anexo 4.3. Ventanas para mostrar información y corregir interferencias 
Anexo 4.3.1. Peaks Display / Pantalla de visualización de picos 

 
 
 

Utilizar la ventana de visualización espectral para ver los 
aspectos que se generan durante un análisis o espectros 
reprocesados a partir de datos almacenados. 

 
 
 
 
 

Anexo 4.3.2. Results Display / Visualización de resultados 
 
 
 
 

Utilizar la ventana de visualización de resultados para ver los datos 
generados a partir del análisis en forma tabular. 

 
 
 
 

Anexo 4.3.3. Calibration Display /Pantalla de calibración 
 
 
 

Muestra la curva de calibración para todos los elementos que se 
analizan en cada muestra. 
También proporciona la concentración de elementos en la calibración 
estándar, la ecuación de calibración que se utiliza y el coeficiente de 
correlación. 
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Anexo 4.3.4. Examinación espectral MSF 
 
 

En este modo, se pueden examinar espectros, se puede observar 
más de cerca, se puede usar para realizar cambios y actualizar la 
longitud de onda máxima o cambiar los puntos de corrección de 
fondo. 
La ventana está dividida verticalmente con el gráfico a la izquierda 
y la leyenda a la derecha. El gráfico muestra todos los espectros de 
un analito elegido para la muestra seleccionada y la leyenda le 
muestra la lista de muestras para cada analito. 

 
 
 

A lo largo de la parte inferior del gráfico hay botones para Seleccionar el primer analito, Seleccionar el 
analito anterior, Seleccionar el siguiente analito, Seleccionar el último analito, Seleccionar el analito y 
Seleccionar una longitud de onda. 

En la parte superior del gráfico, hay una lista desplegable para seleccionar qué 
modo de replicación se muestra. Hay cuatro modos de réplica: réplica promedio, 
primera réplica, última réplica y todas las réplicas. Todas las réplicas muestra todas 
las réplicas de una muestra en particular. 
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1. OBJETIVO 
Establecer la técnica a seguir para el uso y manejo adecuados del HPLC Agilent 1100 series. 

2. ALCANCE 
Este procedimiento es aplicable a todas las operaciones que se realicen con el HPLC Agilent 1100 series 
ubicado en el Laboratorio de Neuroquímica del Instituto Nacional de Neurología y Neurocirugía. 

3. FRECUENCIA 
El presente procedimiento debe llevarse a cabo cada vez que se haga uso del HPLC Agilent 1100 series. 

4. RESPONSABILIDAD 
Es responsabilidad del Departamento de Centro Técnico de Neuroquímica dar a conocer y verificar el 
cumplimiento del presente documento dentro del Laboratorio de Neuroquímica. 
Es responsabilidad del personal del laboratorio de Neuroquímica dar a conocer y hacer cumplir el 
presente procedimiento al personal externo que haga uso del HPLC Agilent 1100 series. 
Es responsabilidad de cada usuario que haga uso del equipo cumplir con lo establecido en el presente 
documento. 

5. DEFINICIONES Y ABREVIATURAS 
Procedimiento normalizado de operación o procedimiento: Documento que contiene las instrucciones 
necesarias para llevar a cabo de manera reproducible una operación. 
Rastreabilidad: Capacidad de reconstruir la historia, localización de un elemento o de una actividad, por 
medio de registros de identificación. 
Registro: Documento que presenta evidencia de las acciones realizadas para demostrar 
el cumplimiento de actividades o instrucciones. 
PNO: Procedimiento normalizado de operación. 
SGC: Sistema de Gestión de Calidad. 
SG: Centro técnico. 
Formato: Hace referencia a la forma como debe ser escrita la información. 
Copia controlada: Copia emitida por el Sistema de Gestión de calidad, la cual cuenta con un sello de la 
leyenda de “copia controlada” y su ubicación es rastreable. 
Capacitación: actividades encaminadas a proporcionar o reforzar conocimientos en el personal. 
HPLC: High Performance Liquid Chromatography ó Cromatografía Líquida de Alta Resolución 
Elución isocrática: se lleva a cabo con un solo disolvente o con una mezcla de disolventes, constante en 
el tiempo de análisis. 
Elución en gradiente: se lleva a cabo variando de forma continua la composición de los disolventes de 
forma que su fuerza vaya incrementando durante el tiempo de análisis.Líneas o canales: parte del 
equipo donde pasan los disolventes a utilizar. 
Fase móvil: disolvente o mezcla de disolventes que se usa como portador de la muestra a analizar y que 
se hace pasar a través de la columna cromatográfica. 
Fase orgánica del método: parte de la fase móvil conformada por solventes orgánicos inmiscibles en 
agua. 
Fase acuosa del método: parte de la fase móvil conformada por agua o una disolución acuosa. 
Parámetros analíticos: condiciones necesarias que se deben controlar para realizar el análisis de una 
muestra. 
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Purga de la bomba: limpieza de las líneas para evitar el paso de burbujas y otros disolventes.  
Proporción de fases: cantidad en porcentaje de las fases del método. 
Corrida: hace referencia al proceso que realiza el equipo para realizar el análisis. 
Método: comprende todos los parámetros necesarios para realizar la adquisición y el análisis de datos 
para una muestra. 
Calibración: la etapa de calibración analítica, se realiza mediante un método que consiste en encontrar 
la recta de calibrado que mejor se ajuste a una serie de “n” puntos experimentales. 
Calibración con patrón interno: la aplicación de este método consiste en realizar medidas simultáneas 
de la respuesta del instrumento al analito y al estándar interno. El estándar interno, se añade en una 
cantidad conocida y constante a la muestra. En la gráfica de calibrado se representa la relación Señal 
analito/Señal de estándar interno en función de la concentración del analito en los estándares. 
Calibración con patrón externo: este método de análisis se aplica en la determinación de un analito, en 
el cual los componentes de la matriz de la muestra como también los reactivos usados en la preparación 
de la misma no interfieren en el análisis, es decir no se tiene un efecto de la matriz en la señal medida. 
A partir de la gráfica, se observa la relación entre la respuesta instrumental y la concentración de los 
estándares. 
Cromatograma: es el gráfico que se obtiene una vez finalizado el análisis de una muestra, representa la 
respuesta del detector en función del tiempo de elución. 
Lavado de columna: procedimiento para limpiar los disolventes utilizados de la columna. 
Buffer: un buffer, también conocido como disolución amortiguadora, disolución reguladora o tampón 
químico, es un sistema constituido por un ácido débil y su base conjugada, o por una base y su ácido 
conjugado que tiene capacidad de oponerse a grandes cambios de pH (en un margen concreto) en una 
disolución acuosa. 
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6. DESARROLLO DEL PROCESO 
6.1. Preparación para el uso del HPLC Agilent 1100 series 

6.1.1. Filtrar las fases móviles empleando una membrana de tamaño de poro adecuado al 
método a utilizar. 

6.1.2. Tener la muestra o muestras a analizar ya preparadas en viales. 
6.1.3. Revisar que la columna haya sido instalada correctamente. 

Nota: la elección de la columna dependerá del método y muestra a analizar. 
6.1.4. Colocar las fases móviles en los envases correspondientes de la siguiente manera: 

Línea A: Agua HPLC 
Línea B: Acetonitrilo 
Línea C: Fase orgánica del método 
Línea D: Fase acuosa del método 

6.1.5. Encendido de los módulos 
6.1.5.1. Verificar que la computadora y los cuatro módulos del cromatógrafo estén 

conectados a la corriente eléctrica (Ver Anexo 1). 
6.1.5.2. Encender la computadora 
6.1.5.3. Ingresar la contraseña para iniciar sesión. 
6.1.5.4. Encender los módulos en el orden planteado a continuación. 
6.1.5.5. Encender el detector y el inyector automático 
6.1.5.6. Abrir la válvula de la bomba en sentido contrario a las manecillas del reloj. 
6.1.5.7. Encender la bomba. 
6.1.5.8. Ingresar al software ChemStation dando click en el ícono de Neuroquímica 2 Online 

que se observa en el escritorio del monitor. 
6.1.5.9. Se abrirá la pantalla “Method and Run Control” donde se muestran y controlan los 

parámetros tanto instrumentales como analíticos (Anexo 2) 
Nota: Si no visualiza se puede abrir seleccionando View > Method and Run 
Control (Anexo 2, número 7) 

6.2. Configuración de gráficos en línea. 
6.2.1. Configurar las señales que se desea observar en caso de ser necesario, de lo contrario 

pase al punto 6.3. 
6.2.2. Realizar la configuración de los gráficos en línea presionar View > Online signals > Signal 

Window 1 (Anexo 2, número 7) 
6.2.3. Pulsar Change en la pantalla Online Plot (Ver Anexo 3) 
6.2.4. Realizar los ajustes siguientes en la ventana Edit Signal Plot (Ver Anexo 3) 
6.2.5. Seleccionar la presión de la bomba en el panel de SeleSGd Signals, 
6.2.6. Fijar un valor de 60 min en x-axis range en el apartado Window. 
6.2.7. Fijar un valor para y-axis range de 200 bar en el apartado Quaternary Pump Pressure, 
6.2.8. Seleccionar la señal del detector a utilizar (DAD A o VWD A) en el panel SeleSGd Signals, 

Nota: si se va a utilizar el DAD considerar que se debe encender la lámpara UV al menos 
20 minutos antes del primer análisis para el calentamiento. 

6.2.9. Fijar un valor de 1000 mAU para el y-axis range. 
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6.2.10. Seleccionar la opción Draw zero line 
6.2.11. Pulsar OK. 

6.3. Purga de la bomba. 
6.3.1. Purgar las líneas del equipo con el objetivo de limpiar el disolvente utilizado por última 

vez y quitar las burbujas de las mismas para evitar dañar la columna. 
6.3.2. Cargar el método predeterminado DEF_LC.M para realizar la purga y acondicionamiento 

del sistema. (Anexo 2, número 14) 
Nota: Si ya se encuentra cargado ir al punto 6.3.7. 

6.3.3. En la Barra de menú seleccionar Method > Load Method (Anexo 2, número 5). 
6.3.4. Seleccionar def_lc.m en la lista de métodos (Ver Anexo 4). 
6.3.5. Pulsar OK para cerrar el cuadro de diálogo y cargar el método. 

6.3.6. Pulsar sobre la bomba  

6.3.7. Seleccionar Set up Pump (Anexo 2, número 38), se abrirá una ventana para la 
configuración de la bomba (Ver Anexo 5) 

6.3.8. Establecer un flujo de 5 mL/min en Flow. en el apartado Control 
6.3.9. Fijar un valor de 100% en la línea que se va a purgar (A, B, C, D) en el apartado de Solvents 

Nota: purgar en orden A, B, C, D. 
6.3.10. Pulsar OK. 

6.3.11. Pulsar el botón (Anexo 2, número 46) en el diagrama del sistema. 
6.3.12. Dejar la bomba purgando durante varios minutos hasta dejar de observar burbujas en la 

línea. 
6.3.13. Monitorear la presión de la bomba en el gráfico Online Plot de la pantalla. 

6.3.14. Detener la purga pulsando el botón   (Anexo 2, número 47). 
6.3.15. Repetir a partir del punto 6.3.9. para realizar la purga a cada línea. 
6.3.16. Cerrar la válvula de la bomba. 

6.4. Acondicionamiento del sistema. 
6.4.1. Revisar que las botellas de disolvente estén llenas. 
6.4.2. Pulsar sobre las botellas de disolvente en el diagrama del sistema, y seleccionar “Solvent 

Bottles Filling” (Ver Anexo 6) 
6.4.3. Colocar los volúmenes reales de cada disolvente (Anexo 2 número 41). 

Nota: Asegurarse de que están marcadas las casillas Prevent analysis if level falls 
below y Turn pump off if running out of solvent. 

6.4.4. Pulsar OK. 
6.4.5. Repetir los pasos 6.3.6. y 6.3.7. 
6.4.6. Fijar un flujo de 1 mL/min en Flow del apartado de Control. 
6.4.7. Establecer las proporciones de las líneas C y D en el apartado Solvents de acuerdo al 

método a utilizar. 
Por ejemplo: 80% acetonitrilo, 20% agua 

6.4.8. Pulsar OK. 
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6.4.9. Monitorear que la presión de la bomba no exceda la presión máxima de 400 bar (Anexo 
2, número 35) en el gráfico Online Plot de la pantalla. 

6.4.10. Dejar el sistema bombeando durante al menos 15 minutos una vez que se hayan estabilizado 

las líneas base. 

6.4.11. Pasar al punto 6.6. si ya se tiene guardado un método a utilizar, de lo contrario, realice la 
creación del método como se indica a continuación. 

6.5. Creación del método a utilizar. 
6.5.1. Revisar que esté cargado el método predeterminado DEF_LC.M. (Anexo 2, número 14) De 

lo contrario, cargue el método como se indica en el punto 6.3.3. y 6.3.4. 
6.5.2. Presionar Method > Edit Entire Method (Anexo 2, número 5) 
6.5.3. Seleccionar sólo la sección de Instrument/Acquisition para su edición (Ver Anexo 7) 
6.5.4. Pulsar OK. 
6.5.5. Configurar los siguientes parámetros en la ventana emergente (Ver Anexo 5) 
6.5.6. Ajustar el flujo Flow y tiempo de parada Stop Time en el apartado de Control 
6.5.7. Ajustar las proporciones de los disolventes a utilizar en el apartado Solvents 
6.5.8. Ajustar los límites de presión en el apartado Pressure Limits. 

Nota: Si se desea realizar una elución en gradiente, en el apartado Timetable presionar el 
botón Insert y ajustar el tiempo y proporción de fases que desee aplicar. De lo 
contrario, si se va a realizar una elución isocrática no modificar el apartado Timetable. 

6.5.9. Pulsar OK. 
6.5.10. Ajustar el volumen de inyección en la ventana emergente (Anexo 8) 
6.5.11. Seleccionar Standard Injection en el apartado Injection 
6.5.12. Fijar un volumen de inyección de 5,0 µl en Injection Volume. 
6.5.13. Pulsar OK. 
6.5.14. Ajustar los parámetros del método correspondientes al detector en la ventana emergente 

(Ver Anexos 9 y 10). 
6.5.15. Establecer los valores de longitud de onda deseados y seleccionar las casillas de Store 

para almacenar las longitudes de onda en el apartado Signals, 
6.5.16. Seleccionar All en Spectrum > Store 
6.5.17. Seleccionar Prerun en Autobalance, para que éste tenga lugar antes del análisis. 
6.5.18. Pulsar OK. 
6.5.19. Seleccionar Method > Save Method As (Anexo 2, número 5) 
6.5.20. Introducir el nombre del método en el campo Name y, si lo desea, agregar los comentarios 

pertinentes (Anexo 11) 
6.5.21. Pulsar OK. 

6.6. Selección del método a utilizar. 
6.6.1. Seleccionar Method > Load Method para seleccionar el método de trabajo. O seleccionar 

el ícono para abrir un método (Anexo 2, número 15) 
6.6.2. Revisar que esté cargado el método. 
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6.6.3. Guardar los cambios antes de realizar la corrida si se modifica algún parámetro del 
método. Method > Save. O seleccione el ícono para guardar un método (Anexo 2, número 
16) 

6.6.4. Ir al punto 6.7. si se desea realizar un análisis individual. 
6.6.5. Ir al punto 6.8. si se desea realizar el análisis de una secuencia de muestras. 
6.6.6. Ir al punto 6.9. si se desea realizar la configuración de una calibración con patrón interno. 
6.6.7. Ir al punto 6.10. si se desea cambiar el tipo de curva de calibración. 
6.6.8. Ir al punto 6.11. si se desea realizar la configuración de una calibración con patrón 

externo. 
6.6.9. Ir al punto 6.12. si se desea realizar una cuantificación o imprimir un reporte. 

6.7. Realizar corridas individuales 
6.7.1. Abrir la ventana Instrument Actuals seleccionando View > Instrument Actuals (Ver Anexo 

12) 
6.7.2. Colocar el vial de muestra en alguna posición de la bandeja del inyector automático. 

6.7.3. Pulsar el botón correspondiente a una muestra individual     , en la barra de 
herramientas (Anexo 2, número 13). 

6.7.4. Seleccionar Run Control > Sample Info 
6.7.5. Configurar los siguientes datos en la ventana emergente “Sample Info” (Anexo 13). 
6.7.6. Configurar lo siguiente en el apartado Sample Parameters 
6.7.7. Anotar la posición en la que se colocó el vial en la bandeja del inyector automático en 

Location. 
6.7.8. Colocar el nombre con el que se desea identificar la muestra en Sample Name. 
6.7.9. Llenar los campos correspondientes con un nombre para identificarlo en Data File. 

6.7.10. Pulsar OK 
6.7.11. Revisar que la línea base y la señal de presión estén estables en el gráfico Online Plot. (Ver 

Anexo 3) 

Nota: Para estabilizar la línea base seleccionar el botón  al lado del ícono del detector 
(Anexo 2, número 40). 

6.7.12. Presionar  

6.7.13. Esperar a que finalice la corrida. 
6.7.14. Repetir los pasos desde el punto 6.7.1. si se desean realizar más análisis de muestras 

individuales. 
6.7.15. Guardar los datos y pasar al punto 6.13. si no se desea realizar ninguna de las acciones 

planteadas en la sección 6.6 y se ha terminado de utilizar el equipo. 
6.8. Realizar corridas en secuencia 

6.8.1. Abrir la ventana Instrument Actuals seleccionando View > Instrument Actuals 
6.8.2. Colocar los viales en la bandeja del inyector automático. 
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6.8.3. Pulsar el botón correspondiente a una secuencia , en la barra de herramientas 
(Anexo 2, número 12). 

6.8.4. Seleccionar Sequence > Sequence Parameters 
6.8.5. Configurar los siguientes datos en la ventana Sequence Parameters (Anexo 14) 
6.8.6. Seleccionar Prefix/Counter en Data File 
6.8.7. Introducir un prefijo, por ejemplo, Seq y dejar el contador en el valor 

predeterminado (0001) 
Nota: Estos parámetros automatizan la asignación de nombres de ficheros de datos 
correspondientes a las muestras de la secuencia. 

6.8.8. Seleccionar Post-sequence Cmd/Macro en Shutdown. 
6.8.9. Seleccionar According to RuntimeChecklist en Part of methods to run. 

6.8.10. Pulsar sobre la flecha hacia abajo y seleccionar STANDBY. 
6.8.11. Fijar un valor de nRdy Timeout de 30 minutos. 

Nota: de esta manera se asegura de que, en caso de producirse una condición de error, 
el sistema se apaga limpiamente transcurridos 30 minutos sin operación. 

6.8.12. Pulsar OK 
6.8.13. Seleccionar Sequence > Sequence Table (Anexo 2, número 6). 
6.8.14. Realizar la tabla de la secuencia en la ventana emergente (Anexo 15). 
6.8.15. Completar la tabla de secuencia con los datos correspondientes. 
6.8.16. Colocar el lugar donde se encuentra el vial en la bandeja del inyector automático en 

Sample Location. 
6.8.17. Colocar el nombre de la muestra en Sample Name. 
6.8.18. Seleccionar el método que se desea utilizar para cada muestra en Method. 
6.8.19. Colocar el número de inyecciones que se desea realizar para cada muestra en 

Inj/Location. 
Nota: También se pueden completar los demás campos si así se desea. 

6.8.20. Pulsar el botón Append Line para añadir una nueva línea a la tabla (Anexo 15). 
6.8.21. Repetir a partir del punto 6.8.16. hasta completar la secuencia a realizar. 
6.8.22. Pulsar OK 
6.8.23. Seleccionar Sequence > Save Sequence As (Anexo 2, número 6). 
6.8.24. Guardar la secuencia. 
6.8.25. Revisar que la línea base y la señal de presión estén estables. 

Nota: Para estabilizar la línea base seleccionar el botón   al lado del ícono del 
detector (Anexo 2, número 40). 

6.8.26. Presionar  

6.8.27. Esperar a que termine la corrida. 
6.8.28. Guardar los datos y pasar al punto 6.13. si no se desea realizar ninguna de las acciones 

planteadas en la sección 6.6 y se ha terminado de utilizar el equipo. 
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6.9. Configuración de una calibración con patrón interno 
6.9.1. Seleccionar View > Data Analysis. Se observará la pantalla de análisis de datos (Ver anexo 

16) 

6.9.2. Pulsar el icono  para cambiar al espacio de trabajo de calibración. 
6.9.3. Cargar la señal A del primer fichero de datos 005-0101.D de la siguiente manera 
6.9.4. Seleccionar File > Load Signal. 
6.9.5. Ver Anexo 17, ver donde se debe navegar hasta la carpeta HPCHEM\n\DATA\DEMO, 

donde n es el número del instrumento. 
6.9.6. Seleccionar el fichero de datos 005-0101.D. 
6.9.7. Seleccionar la primera señal, DAD1 A. 
6.9.8. Marcar la casilla Integrate after load, de modo que se proceda a la integración tras la carga. 
6.9.9. Presionar OK. 

6.9.10. Seleccionar Calibration > New Calibration Table 
6.9.11. Configurar lo siguiente en la ventana emergente (Ver Anexo 18) 
6.9.12. Seleccionar la opción Automatic Setup. en el grupo Calibration Table 
6.9.13. Fijar un nivel 1. 
6.9.14. Fijar una cantidad predeterminada, Default Amount. 
6.9.15. Pulsar OK para cerrar el cuadro de diálogo y configurar la tabla de calibración. 
6.9.16. Introducir nombres para los compuestos en la columna Compound de la tabla de 

calibración. 
Por ejemplo: Compound 1, Compound 2, Compound 3 y Compound 4. 

6.9.17. Guardar los datos y pasar al punto 6.13. si no se desea realizar ninguna de las acciones 
planteadas en la sección 6.6 y se ha terminado de utilizar el equipo. 

6.10. Cambio del tipo de curva de calibración 
6.10.1. Seleccionar View > Data Analysis > Calibration > Calibration Settings para mostrar el 

cuadro de diálogo Calibration Settings (Anexo 19) 
6.10.2. Establecer el tipo, Type en el grupo Default Calibration Curve, 
6.10.3. Observar el cambio producido en la curva de calibración. 
6.10.4. Presionar OK para cerrar el cuadro de diálogo. 
6.10.5. Ir al punto 6.12. para volver a cuantificar la muestra problema y observar el cambio 

producido en los resultados seleccionar. 
6.10.6. Guardar los datos y pasar al punto 6.13. si no se desea realizar ninguna de las acciones 

planteadas en la sección 6.6 y se ha terminado de utilizar el equipo. 
6.11. Configuración de una calibración con patrón externo 

6.11.1. Repetir los puntos 6.9.1. al 6.9.16. 
6.11.2. Pulsar sobre la columna ISTD del pico 2.  
6.11.3. Seleccionar la flecha hacia abajo y seleccionar Yes. 
6.11.4. Pulsar en cualquier otro lugar de la tabla de calibración para mostrar el cuadro de 

diálogo Calibration Table (Ver Anexo 20). 
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6.11.5. Fijar un valor de ISTD # de 1 y una cantidad de patrón interno, ISTD Amount, de 200 en el 
cuadro de diálogo Calibration Table, 

6.11.6. Presionar OK para cerrar el cuadro de diálogo Calibration Table. 
6.11.7. Fijar una cantidad de patrón interno de 200 en la columna Amt del pico 2, 
6.11.8. Mostrar la ventana Specify Report seleccionando Report > Specify Report 
6.11.9. En Destination, seleccionar la impresora, Printer, y la pantalla, Screen. 

6.11.10. En Quantitative Results presionar la flecha hacia abajo del cuadro combinado Calculate y 
seleccione ISTD en la lista. 

6.11.11. Ver que el valor de Based On es Area y el de Sorted By es Signal, de modo que los resultados 
cuantificados se basen en las áreas y se ordenen por señales. 

6.11.12. Seleccionar File > Save As > Method 

6.11.13. Guarde el método como testcal2.m 
6.11.14. Cargar la señal DAD1 A del fichero de datos 005-0102.D ubicado en la carpeta DEMO como 

se indica en los puntos 6.9.3. al 6.9.9. 
6.11.15. Imprimir un informe cuantitativo en la pantalla y en la impresora seleccionando Report 

> Print Report 
6.11.16. Guardar los datos y pasar al punto 6.13. si no se desea realizar ninguna de las acciones 

planteadas en la sección 6.6 y se ha terminado de utilizar el equipo. 
6.12. Cuantificación e impresión del reporte. 

6.12.1. Seleccionar View > Data Analysis > Report > Specify Report 
6.12.2. Seleccionar Screen y Printer, si se desea imprimir, en Destination. 
6.12.3. Seleccionar la flecha hacia abajo del cuadro combinado Calculate en Quantitative Results y 

seleccionar ESTD o ISTD en la lista, dependiendo si es una calibración con patrón 
interno o externo. 

6.12.4. Ver que el valor de Based On es Area y el de Sorted By es Signal, de modo que los valores 
cuantificados se basen en las áreas y se ordenen por señales. 

6.12.5. Seleccionar Add Chromatogram Output en Style, para que el informe incluya el 
cromatograma. 

6.12.6. Pulsar OK para cerrar el cuadro de diálogo Specify Report. 
6.12.7. Seleccionar File > Save As > Method 
6.12.8. Guarde el método 
6.12.9. Cargar la señal DAD1 A del fichero de datos 005-0101.D ubicado en la carpeta DEMO como 

se indica en los puntos 6.9.3. al 6.9.9. 
6.12.10. Seleccionar Report > Print Report para imprimir un informe cuantitativo en la pantalla y, 

si se seleccionó la opción en la impresora. 
6.12.11. Guardar los datos y pasar al punto 6.13. si no se desea realizar ninguna de las acciones 

planteadas en la sección 6.6 y se ha terminado de utilizar el equipo 
6.12.12. Integración de una señal 

6.12.12.1. Seleccionar View > Data Analysis 

 
6.12.12.2. Pulsar el ícono ,para cambiar al espacio de trabajo de integración. 
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6.12.12.3. Seleccionar File > Load Signal 
6.12.12.4. Cambiar a la carpeta TEST en la ventana Load Signal 
6.12.12.5. Seleccionar el archivo guardado previamente en la ventana Sample Info, en el 

apartado Data File: Filename y Subdirectory. 

6.12.12.6. Pulsar el icono  en Integration/Report, para cambiar a la tabla de eventos de 
integración. 

6.12.12.7. Pulsar la flecha hacia abajo en la tabla de eventos de integración, para mostrar la 
lista de señales disponibles y seleccionar la señal VWD1 A, la señal DAD1 A o la 
señal MWD1 A, dependiendo del detector utilizado para adquirir los datos. 

 
6.13. Lavar columna 

6.13.1. Realizar un lavado a la columna para evitar dejar residuos de buffer o disolventes que 
puedan dañarla. 

6.13.2. Pulsar sobre la bomba y seleccionar Set up Pump (Anexo 2, número 38). 

6.13.3. Ajustar los siguientes parámetros en la ventana emergente Set up Pump. 
6.13.4. Cambiar las líneas C y D por las A y B, dejar la misma proporción del método utilizado 

en el apartado Solvents 
6.13.5. Pulsar OK. 

6.13.6. Pulsar el botón . 
6.13.7. Monitorear la presión de la bomba en el gráfico Online Plot de la pantalla, una vez que se 

haya estabilizado disminuir las proporciones hasta llegar a un valor de 50% B y 50% en 
A. 

6.13.8. Dejar la bomba lavando durante el tiempo necesario de acuerdo a las fases empleadas. 

6.13.9. Detener el lavado pulsando el botón  
6.13.10. Pulsar Yes para confirmar el apagado. 

6.14. Apagar 
6.14.1. Cerrar el programa y todas las ventanas de la barra de herramientas. 
6.14.2. Apagar la computadora 
6.14.3. Apagar los módulos en el siguiente orden: Bomba > Automuestreador> Detector 
6.14.4. Desconectar de la corriente eléctrica. 
6.14.5. Realizar el registro correspondiente en la bitácora de uso con el formato FOR-SG-012/1. 

6.15. Registro en el Formato de conocimiento 
6.15.1. Posterior a la lectura del presente documento, llenar el formato FOR-SG-011/1 Registro 

de conocimiento de PNO´s. 
6.15.2. Únicamente se realizará el registro en el formato FOR-SG-011/1 la primera vez que se 

lea el presente documento. 
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FINAL. 

7. FORMATOS 

Código de formato Nombre del formato 

FOR-SG-011/1 Registro de conocimiento de PNO´s 

FOR-SG-012/1 Registro de uso del equipo HPLC Agilent 1100 series. 
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11. ANEXOS. 
Anexo 1. Partes del equipo 
El equipo se compone de los siguientes módulos. 
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Anexo 2. Pantalla Method and Run Control e íconos del sistema. 
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Anexo 3. Pantalla Online Plot y Ventana Edit Signal Plot. 
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Anexo 4. Selección de método def_lc.m. 

 
Anexo 5. Ventana Set up Pump 

 



Procedimiento Normalizado de Operación para uso y manejo del 
HPLC Agilent 1100 series 

Página 21 de 32 PNO-SG-01/1 

 

 

 

Código: PNO-SG-01  Departamento emisor: CENTRO TÉCNICO 1ª Edición 

Fecha de Emisión: 10-Abr-22 Fecha de Revisión: Abr-22 Fecha de autorización: Abr-22 

Próxima revisión: May-22 Fecha de aplicación: Oct-25 

 

Anexo 6. Ventana Solvent Bottles Filling. 

 

Anexo 7. Selección de Instrument/Acquisition 
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Anexo 8. Ventana Set up Injector 
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Anexo 9. Ventana DAD Signals. 
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Anexo 10. Ventana VWD Signal 

 

Anexo 11. Guardar método. 
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Anexo 12. Ventana Instrument Actuals 
 

Anexo 13. Sample Info 
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Anexo 14. Sequence Parameters. 

 
Anexo 15. Sequence Table. 
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Anexo 16. Pantalla de Análisis de datos e íconos 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
. 

Botones de opción de señal 
1. Superpone cromatogramas en un eje de tiempo. 
2. Apila cromatogramas 
3 y 4. Ajuste los ejes y al mismo valor máximo o valores máximos diferentes 
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Botones de tareas de análisis de datos 
1. Integración 
2. Calibración 
3. Señal 
4. Espectral 

 

Iconos de archivos de datos 
1. Señal(es) de carga y espectros de un archivo de datos. 
2. Cargue la(s) señal(es) de un archivo de datos y superpóngalas con las señales actuales. 

 

 
1. Alterna la visualización de la barra de herramientas de gráficos 
2. Ampliar la ventana 
3. Alejar 
4. Herramienta Puntero (Establecer en modo de selección) 
5. Seleccione el espectro en cualquier posición de tiempo 
6. Seleccione el espectro en el vértice del pico 
7. Promedie un conjunto seleccionado de espectros 
8. Seleccione un conjunto de espectros de un pico 
9. Seleccione el espectro para establecer como primera referencia 
10. Seleccione el espectro para establecer como segunda referencia 
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Anexo 17. Ventana Load Signal 

 

Anexo 18. Ventana Calibrate. 
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Anexo 19. Ventana Calibration Settings 

 
Anexo 20. Ventana Calibration Table. 


